EEE 4134 VLSI I Sessional

EEE 4134 VLSI | Laboratory
Lab O (Introductory Lab)

Logging into Cadence Server, Tool Setup, Cell Library Creation, Introduction
to Custom IC Design flow

Objectives:
e To login, start a shell tool and start the Cadence Virtuoso software
e To learn about PDK and add the PDK library to the Library Manager
e To create a working library and to get familiar with technology
e To be familiar with Custom IC Design flow

Logging in, starting a shell tool, and starting the Cadence Tool Suite

1. Find Desktop shortcut icon for XLaunch. Double-click on it. Click Next, Next, Next, Finish (in
that order) in the windows that pop-up one after another.

XLaunch -
Shortcut

9:58 AM

s B jygms

3. Select VLSI_LAB under ‘Saved Sessions’ category. Click Load. The window will look like the

following one:

#8 PuTTY Configuration X
Categony:

=8 Sgssion Basic aptions for your PuTTY session

e Lpglgjing Specify the destination you want to connect to
Tﬂlﬁgjboard Host Name f(or IP address) Port
- Bl [172.16.16.160 |[22 |
- Featuras Connection type:

= Window (ORaw (O Telnet () Rlogin @ SSH () Serial
Fppea@nce Load, save or delete a stored session
- Behaviour
.. Translation Saved Sessions
- Selection |‘\-"LS I_LAB |
- Colours Default Settings Lozd

“ Connection
- Data Save
- Proxy
- Telnet Delete
- Rlogin
+- 55H
""" Senial Close window on exdt:

(O Mways () Never () Only on clean exit

About Open Cancel
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Click Open. A Security Alert window may pop-up. Click Yes.
4. Now you will see a Terminal window which prompts you for login.

@ 1721616160 - PuTTY - O >

5. Log in to your workstation using user ID and password. Your user name and your password will
be your student ID. When you are typing your password, the command window will not display
the characters you type in, so make sure you are typing the right password. After logging in to your
account, Terminal window should look like the following:

E& 120105001 @aust:~

6. Type csh and press ‘Enter’ key.
Then type source cshrc_qand press ‘Enter’ key.

The following message will be displayed in the Terminal window:
Welcome to Cadence tools Suite

That means you can use Cadence tools now.

7. Go to your working directory by typing: ed cic

8. Type virtuosos&

A sample command prompt screen is shown below:

9. Virtuoso® Command Interpreter Window (CIW) appears at the bottom of the screen. From
the CIW menus, all Cadence main tools, online help and options can be accessed. In the window
area, all kind of messages (info, errors, warnings, etc) generated by the different Cadence tools
appear. You can also introduce commands.
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|I| Virtuoso® £.1.6 - Log: /home/fall16/120105001/CD5.log — a *
File Tools Options Help cadence
Loading ci.cxbt
Loading ams. cxt .
Virtuoso Framework License (111) was checked out successfully. Total checkout time was 0. 05s. E
! ~
- i1} »
nmouse L: P: R:
1 | * J

Another window ‘What’s new in 1C6.1.6 Overview’ appears too. Execute File-=>Close and Do
Not Show Again and this window will not appear the next time you open Virtuoso.

NOTE: You have to perform these steps above in every class where Cadence tools will be used.
The following figure summarizes the steps:

Start XLaunch

v
Start Putty

Open VLSI_LAB session
v
Login to server

v
Type the commands one
by one and press Enter:
csh
source cshrc q
cd cic
virtuosoé&
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Custom IC Design Flow

The following figure shows the basic design flow of a custom IC design, together with the Cadence
tools required in each step:

Design Specifications

v

\Ad

Schematic Entry

v

Simulation

No

Yes

\A4

Layout Design

.2

Layout Verification

No

Yes

Parasitic Extraction

v

Post-Layout
Simulation

No /ok?

Yes

Format Conversion
(CIF, GDS 1)

.2

Fabrication

v

Measurements

Cadence
Tools

Virtuoso Schematic Editor L

ADE L (Spectre)

Virtuoso Layout Editor L/XL

Assura DRC and LVS

Quantus QRC

ADE L (Spectre)

First, a schematic view of the circuit is created using Cadence Virtuoso Schematic Editor L.
Then, the circuit is simulated using Cadence Analog Design Environment (ADE L). Different
simulators can be employed; some sold with the Cadence software (e.g., Spectre) some from other
vendors (e.g., HSPICE) if they are installed and licensed.

Once circuit specifications are fulfilled in simulation, the circuit layout is created using Virtuoso
Layout Editor L. The resulting layout must verify some geometric rules dependent on the
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technology (design rules). For enforcing it, a Design Rule Check (DRC) is performed. Optionally,
some electrical errors (e.g. shorts) can also be detected using an Electrical Rule Check (ERC).
Then, the layout should be compared to the circuit schematic to ensure that the intended
functionality is implemented. This can be done with a Layout Versus Schematic (LVS) check. All
these verification tools are included in the Assura software in Cadence.

Finally, a netlist including all layout parasitics should be extracted using Quantus QRC tool, and a
final simulation of this netlist should be made. This is called a Post-Layout simulation, and is
performed with the same Cadence simulation tools.

Once verified the layout functionality, the final layout is converted to a certain standard file format
(GDSII, CIF, etc.) depending on the foundry using the Cadence conversion tools.

Learning fundamentals of PDK and adding PDK library to the Library Manager

Cadence is an Electronic Design Automation (EDA) environment that allows integrating in a single
framework different applications and tools (both proprietary and from other vendors), allowing to
support all the stages of IC design and verification from a single environment. These tools are
completely general, supporting different fabrication technologies. When a particular technology is
selected, a set of configuration and technology-related files are employed for customizing the
Cadence environment. This set of files is commonly referred as a process design Kit.

All VLSI designs start with a Process Design Kit known briefly as PDK. A PDK contains the
process technology and needed information to do device-level design in the Cadence Design
Framework Il (DFII) environment.

Throughout the labs we will use a generic, foundry independent 90nm CMOS mixed-signal process
kit developed by Cadence. We will call it generic PDK 90 nm briefly as gpdk090. A PDK contains
all the necessary design and technology data to successfully design and simulate a VVLSI chip on a
particular foundry. The foundry provides the necessary technological data, design rules, and the
device models. Also PDK contains schematic symbols with all necessary views, as well as device
extraction rules for Layout versus Schematic (LVS) check. It also provides parasitic extraction
rules.

Creating a library and attaching technology to library

All the entities in Cadence are managed using libraries, and each library contains cells. Each cell
contains different design views (the structure is similar —and physically corresponds - to a directory
(library) containing subdirectories (cells), each one containing files (views). Thus, for instance, a
certain circuit (e.g. an inverter) can be stored in a library, and such library can contain the different
logic blocks (basic gates, flip-flops, registers, etc) stored as cells. Each block (cell) contains
different views (schematic, layout, symbol, etc.).
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There are usually three types of libraries:
e A set of common Cadence libraries that come with the Cadence software (containing basic
components, such as voltage and current sources, R, L, C, etc).
e Libraries that come with a certain design kit (e.g. gpdk090) and that are related to a certain
technology (e.g. transistors with a certain model attached, etc).
e User libraries; where the user stores its designs. These designs employ components from the
Cadence/design kit libraries.
It is recommended that you use a library to store related cell views; e.g., use a library to hold all the
cell views for a single project (that can involve a complete chip design). In our example, we are
going to create a new library for our design and attach it to desired technology library.
1. In the CIW, execute File >New-Library.
2. The ‘New Library’ form appears. In the name field of the New Library type mylib or any name
of your choice.

X Mew Library — O *
Library Technology File
Mame myLib| — Compile an ASCIH technology file

Directary (non-library directaries) — Reference existing technology libraries

]

Attach to an existing technology library

— Do not need process infarmation

Design Manager

Mo design manager setup found

shome /£alll6,/120105001 /cic

_ Compression enabled

Cancel Diefaults Apply Help
3. Select Attach to an existing technology library and click OK. ‘Attach Library to Technology

Library’ window will appear.
X Attach Library to Technology Library — O X

Mews Libirary mylihb

Technology Library analogLib
avTech
hasic S
cdsDefTechLih

qpdk045

m Cancel Apply Help
4. Select gpdk090 technology library and click OK. This will be the technology chosen for your
design (that you will employ eventually for fabrication). Now all the designs made in this library
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are technology-dependent (e.g., the schematic MOS symbols have by default the model for this
technology, the available layout layers correspond to this technology, etc.).
5. In the CIW, the following message will appear:

Loaded qpdkl80/1ibInit. il successfully!
Created library "mylib" as " home/falll6 120105001/ cic/mylib"
INFO (TECH-180011): Design library 'mylib' successfully attached to technology libracy 'gpdk090°.
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EEE 4134 VLSI | Laboratory
Lab 1

Introduction to Virtuoso Schematic Editor, Creating Inverter schematic,
Performing transient simulation of Inverter schematic, Power and delay
measurement of designed inverter for different corners

Objectives:
e To learn how to draw schematic of basic logic gates in Cadence Virtuoso
e To learn how to perform transient simulation of logic gates
e To learn about process corners and their effects on delay and power dissipation
e To learn how to measure power dissipation and propagation delay of logic gates

Schematic Entry: Creating a Schematic cell view
In this exercise, you will learn how to enter simple schematic and run a simulation to perform
timing simulation of an inverter designed using gpdk090 technology.

1. In the Command Interpreter Window (CIW), execute File >New>Cellview. Set up the ‘New
File’ form as follows:

Library: mylib, Cell: inverter, View: schematic, Type: schematic, Application: Open with:
Schematics L

X New File - 0 %
File

Library thylik n
Cell inverter|

e schematic

Type schematic B
Application

Dpen with Schematics L [~

_ Always use this application for this type of file

Library path file
Jhome A£al11e /180105001 fedic feds. ik

@3 concel  Help
2. Click OK when done. The following window may appear. Click Yes/Always.
X Mext License — O e

ey (iclic-23) License Viruoso_Schematic_Editor_L ("35700") is not available to run Schematics L
\',) Would you like to try checking out the license Yiduoso_Schematic_Editor <L ("35115") instead?
Yes Mo Ahways | Mewer | Help

A blank schematic window for the inverter design appears.
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@ Virtuoso® Schematic Editor L Editing: mylib inverter schematic - O X
Launch File Edit ¥View Create Check Options Window Help cadence
- ' i ) 7] : A F I Q @ = :
=" 0@ X O T, ¢ -7 7T QS Q@FE WL LESE
- - R - | N B S B -
Havigator
" Default B
Q B-
MName zl
= inverter
Property Editor 78 %
N S———
imouge L: sch3ingleselectPl) h: defMew() R: schHitousePopUp(
102 | = | Cme: el 0

Schematic Entry: Adding an Instance to Schematic

Next, we will create simple schematic of an inverter consisting of an NMOS and a PMOS.
1. To create an instance, you can execute Create= Instance in Virtuoso schematic editor window
or simply use shortcut key “i”. The following window will appear:

X Add Instance - O X
Litarary Browse
Cell

Wiew symbol

Mames

o Add Wire Stubs at:
— all terminals & registered terminals anly

Array Rows 1 Columns 1

42 Rotate Ab Sideways | =2 Upside Down

m _Qancel_ ) Defaults ) _ﬂelp )

2. Click Browse to select a library component. Another window will show up. Choose Library:

gpdk090, Cell: nmoslv, View: symbol. (Note that while you are doing this, the ‘Add Instance’
form is getting updated as well).
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X Library Browser - Add Instance - [m] x X Add Instance - O x
_ Show Categories Library  gpdk090 Browse
Library Cell View call ey
gpdk0s0 nmos1v symbaol View symbol
analogLib mimcap B View ~| Lock | Size | | | Mames
basic ndio ads 19k
cdsDefTechLib auCdl 19k o Add Wire Stubs at
gpdk04s nmosiv_3 aulLvs 19k  all terminals @ registered terminals only
nmos 1v_hvt hspiceD 19k =
gpdki1g0 nmos1v_hvt_3 spectre 19k j Array Rows 1 Columns 1
o nmos1v_Iso K
sample nmos1v_nat ] 42 Rotate A Sideways = Upside Down

nmoszv = — — :
nmoszv_3 qpdk090_rmoslv
nmosZv_nat
nmoscaply Multiplier 1
nmoscapi1v3 Length 100n M

= — Total Width 120n ¥

[Lib: gpdkoso [Free: 743.39G
Finger Width 120n M
Close _Filters... Display... _Help

3. Make sure that the view name field in the form is set to symbol. After you complete the form,
move your cursor to the schematic window and click left to place the component.

HE:_FHI'I'ID.'_.-'-"I 'r'”

Similarly, add pmos1v cell.

4. Now we can adjust the sizes of the transistors by editing instance properties. Left click on the
NMOS to select the component. Then, press “q” to modify its properties, or in schematic editor
window, execute Edit = Properties = Object.

You will update the Library Name, Cell Name, and the property values given in the table below as
you place each component. The inverter design contains the following cells from the following
libraries.

Library Name | Cell Name | Properties/Comment

gpdk090 nmoslv For NMO, Width=240n (this is 2x the minimum channel width)
gpdk090 pmoslv For PMO, Width=480n

analogLib vdd

analogLib gnd

For example, while modifying the transistor width for NMOS, set Total Width to 240n, and then
press ‘Tab’ key and the Finger Width will be set to the same value. Click OK.

Repeat this for PMOS to set Total Width and Finger Width to 480n. To deselect any object, press
keyboard command “Ctrl+d”.

If you place component in the wrong location, select the component and press ‘m’ on keyboard and
move it to your desired location. After entering the components, click Cancel in the Create
Instance form or press Esc keeping your cursor in the schematic window.

Next, instantiate power nets (cell vdd and gnd from analogL.ib library).
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Library Cell View Library Cell View
analoglLib vdd symbol analoglib gnd symbal
analoglLib veed wiew ~| Lock Size analoglib diffistbprobe View ~| Lock Size
avTech veces avTech diode .
hasic veesp symbol_sfarm 13k | |[basic durmmy 3 symbol_xform 13k
cdsDefTechLib vCres cdsDefTechLib fourier
gpdkO4s UCWS gpdk045 fourierzeh
gpdko3o UCWsp gpdka3o fracpole
gpdk180 vdo gpdkiao
rryliby mmylib gnda
sample vdd_inherit sample gndd

vdda iam

vddd 5 ihis_buffer

vee I ibit

veea — \dc o i

[Lib: analogLib [Free: 701.55G [Lib: analogLib [Free: 701.55G

_Close _Filters.. _Display.. Help ,  ( Close _Fiters... Display... Help

5. Execute Create = Pin or press ‘p’ on keyboard. ‘Add Pin’ form will appear. Enter the name of
the pin (e.g. in), Direction of the pin (e.g. input/output etc.). Add all the pins (in and out) to the
schematic. For an inverter, gate input pin (e.g. in), is the input pin. And output pin (e.g. out) at the
common node between drains of NMOS and PMOS is output pin. So, select Direction property as
input for in, and output for out.

X Add Pin - m| X X AddPin - m} X

Pin Marmes in| Pin Mames out

Direction input B 5us Expansion @ off L on Direction \output B3 eus Expension @ off U on

Usage Fchematic n Placement ® single o multiple  Usage schematic ﬂ Placement ® single _ multiple

Signal Type signal |3 Signal Type signal K3

Attach Met Expression: & No o vYes Attach Met Expression: & Moo oYes

Property Mame Property Marme

Default Met Mame Default Met Mame

Font Height 0. 0625 Fant Style jetick Fant Height 0. 0625 Font Style gtick J

- A Rotate - ¥_|h, Sideways_} 5..:? Upside DDWD - Show Sensitivity == = 42 Rotate - ¥_||;‘, Sideways_/ f..ﬂ Upside DDWD - Show Sensitivity == ”
m _ Cancel ) Defaults | Help m _ Cancel | Defaults | Help

6. Use Add-2Wire menu or simply press ‘w’ key to enter wiring mode / Esc to exit. It is a good
practice to periodically save your work by clicking on Check and Save button (the checkmark
button just below the Tools menu). You can also save your work from the drop-down menu

File>Save.

The final schematic looks like the following one:
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7. Click Check and Save.

8. Check CIW for errors. If there is no error, you should see the following message:

INFO (SCH-1170): Extracting "inwverter schematic"
INFO (SCH-1426) . Schematic check completed with no errors.
INFO (SCH-1121): "mylib inwerter schematic" sawed.

Netlist Creation and Simulation using Spectre

The following flowchart shows the steps to be executed to simulate a design using ADE L.:

. LaunchADEL |

v
Setup Model Libraries

gpdk090_mos.scs
b
Choose Section
TT slv
v
| Setup Stimuli |
l
~ Choose Analysis |
I
~ Select Outputs |

!
| SaveSession |

!
. RunSimulation |

1. In the Schematic editor window, execute Launch = ADE L. The following window may appear.
Click Always.
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X Mext License — O et

ficLic-23) License Analog_Design_Environment_L ("35200") is not available to run A0DE L.
Would you like to try checking out the license &nalog_Design_Environment_xL {"35210") instead?

Yes [0 S lway s Mever Help

Analog Design Environment (ADE) L window will appear.

“ ¥ ADE L (13 - mylib inverter schematic — O prd
Launch Session Setup  Analyses Wariables Outputs  Simulation  Besults Tools Help cadence
I=F=IR SR =" =
: i fAnalyses FIEX
Design Yariahles Sac
Type | Enable| Arguments | ==
Mae | W alue | @
[
®
Outputs zinQ
MamesSignal/Expr | Walue | Plat| Save| Save Options |

N Plot after simulation: |Auto n Plotting mode: Replace n

2(3) | Choose Design .. | Status: Ready | T=27 C | Simulator: spectre
2. Set up the model libraries by executing Setup—=Model Libraries. ‘Model Library Setup’

Window will appear:
X spectrel: Model Library Setup — O x

|Madel File |Section |
B- Global kodel Files
i o Mtechiprocess/gpdk090/ibs 0a22/gpdk030/ f imodels/spectre/gpdk030.scs [N

tl=Click here to add model files —

3. Click twice on the file name given under Global Model Files. An ash coloured button will
appear.

BB process/gpdkn90dibs 0a2 2 gpdk030s / imodelsispectresgpdk0an scs T SR
Click on the button. ‘Choose Model File’ window will appear.
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X Choose Model File *

Laak in:

B9 Aechiprocess/gpdkig/models/spectre n Q % ] =

E Comput

= 120105

-
Ll

File name:

Files of type: |

4. Select gpdk090_maos.scs from the list. Click Open.

DO DO E

gpdk0sn. pef
gpdk0anscs
gpdk030_hipolar.scs
gpdk030_capacitor.scs
gpdk030_diode scs
gpdk030_mos.scs
Qqpdk030_mos_age.scs
gpdk0s0_mos_iso.scs
gpdk0s0_moscap.scs
gpdk0s0_resistarscs
res_polysn.ya
res_vava

resd_wa.wa
rhoise_va.va

e

n MCanceIJ

]

In this model file, there are models to simulate various corners like fast-fast (FF), fast-slow (FS),
typical-typical (TT) etc. These are called process corners, depending on the speed of MOS
transistors (NMOS and PMOS). Refer to the following figure for the definition of process corners:

A

FF
g SF
LL
[7p]
(@)
>
o
FS
S
> S
o
(7p]
Slow Fast

nMOS

We will choose the section typical from the Section scroll bar and select the section 'TT_sl1v'.
These will enable us to use the TT models of the 1.2 VV MOS transistors. Click OK.

|Model File |Section |
= Global Model Files
L o Mtech/process/gpdk090/models/spectre/gpdk090_mos.scs TT 51w

il |=Click here to add model files

5. Now execute Setup = Stimuli to assign signals to pins of the inverter.
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X setup Analog Stimuli — O x

Stimulus Type & |nputs _ Global Sources r

OFF 1in _.-"'g'ruﬂ.! VljltEi.g'Et hit

-

> M
@I cCencel . Apply o Change | Help
6. In ‘Setup Analog Stimuli’ window, select Global Sources. Now you can see global power net
vdd!.
Click on Enabled, Select dc under Function and Voltage under Type. The filled up form for
‘vdd!” will look like the one below. Click Apply (it is a must, clicking OK will close the window

and the value will not be saved).
X setup Analag Stimuli - O X

Stimulus Type « Inputs & Global Sources

0N wdd! fgnd! Voltage dc "DC woltage'=1.2

Enahled Function 8C n Type  (Woltage n

DC vaoltage 1.2 v

€& conce &pply | Change || Help

7. For input pin ‘in’, we have to set a pulse waveform. The following figure shows the definition of

pulse parameters:
A Voltage

Voltage2|~ — _} T

Voltagel

|

|

|
Time mne Time > |

Period Period Time

For setting signal to input pin ‘in’, select Inputs in Setup Analog Stimuli window. Click on
‘Enabled’, select Function: ‘pulse’, Type: ‘Voltage’. Parameters for pulse source will be as
follows: Voltagel = 0V, Voltage2 = 1.2V, Period = 40n, Delay time = 3n, Rise time = 3n, Fall
time = 3n, Pulse width = 20n. Click Apply and then click OK.
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stimulus Type

& Inputs _ Global Sources —

0N  in fgnd! Voltage pulse "Voltage 1"=0 "Voltage 2"=

B Il ™ -
Enabled Function  ([pulse n Type  Voltage n
DC voltage

&C magnitude
&c phase

HF magnitude
P&C magnitude
P&C phase
Yoltage 1
Yoltage 2
Period

Delay time
Rise time

Fall time

Fulse width

0

1.2

400

In

In

In

20n =

@I concel . Apply o Change | Help

EEE 4134 VLSI I Sessional

8. Now choose the analysis to be done from Analyses 2Choose. Select transient (tran) analysis to
be done. Provide 100n as ‘stop time’. (Analysis: tran, Stop Time: 100n, Accuracy Defaults:

moderate). Click OK.
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X Choosing Analyses -- ADEL (1) - | *
Analysis & tfran i dC s ac — hoise

o — SENS — dcmatch o acmatch

- sth o P12 o 5[ — envip

o Pss _ pac _ psth _ pnoise

et — psp — 0pss — fpac

— gpnoise o gpsr — qpsp s hb

. hhac _ hbnoise _ hbsp

Transient Analysis

Stop Time 100

accuracy Defaults (errpresef)

__ conservative » moderate _ liberal

__ Transient Moise

Dynamic Parameter
Enabled Cptions...

Cancel Defaults Spply Help
9. Select the output to be plotted by executing Outputs=To be plotted 2Select on Design in the

ADE window. Schematic editor window will pop up, select ‘out’ and ‘in’ to be plotted and saved.
When you select them, you will see colors being assigned to these pins.

Marme =
= inverter
- (@) MWD (nmosTy)
=2 PIND {ipin)
=gl FIMT {opin)
- PRAD (pmost )
], wdd!
- = jn:P__0
- = outP__1

Property Editor TR X

10. Your Analog Design Environment window should now look like the following:
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“Y ADEL (1) - mylib inverter schematic — O b4
Launch Sesszion Setup  Analyses Mariahles Outputs  Simulation Besults Tools Help cadence
el a8 d
: i fnalyses L7 =
Design Yariables Eac
Type | Enahle| Arguments =
Mame | Yalue 1 tran o 0 100n moderate @

®
< - O
Q
_ MamedSignal/Ex=pr | Walue | Plaot | Save| Save Cptions
1 in » ally il
5 out " ally

-~
L 1]

Plot after simulation: |Auto n Plotting mode: Replace n

2(3) | Environment ...

| Status: Ready | T=27 C | Simulator: spectre |

11. Before closing the Virtuoso Analog Design Environment window, it is a good idea to save
design settings in a state file, so we can load it up next time. To do this, execute Session = Save
State and save state name in the ‘Save As’ field as state inverter. Next time you run Cadence, you
can simply load the simulation settings from this file.

X Saving State -- ADE L (1) - ] *
‘Save State Optian & Directory o Cellview ™
Directory Options
State Save Directory «f artist_states Browse... _
Save As inverter
Existing States
Cellview Options
Library mylib
Cell inverter Brawse...
' —_—
State spectre_statel
[ i} - ViN

Cancel Apply Help
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12. Now run the simulation by executing Simulation =>Netlist and Run in the ADE window. The
simulation will run and the output will appear in Virtuoso Visualization & Analysis XL window as
shown below.

1 mylib inverter schematic [

13. Finally, we are going to separate the plots into two sub-graphs. Click on the following icon for
splitting graphs.

A
vy

The final plot should look like the one shown below:
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Definition of rise time, fall time and propagation delay

Three main timing parameters are associated with CMOS devices — rise time, fall time, and
propagation delay. Most often, in discussion with regard to these parameters, the system response
of an inverter is used. The following figure defines rise time, fall time and propagation delay of a

gate with the example of an inverter:
Voltage (in)

A

P Time

—H
o
I
—
@;
=

Voltage (out)
A >,

P Time
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Referring to the above figure, rise time is the time that it takes to charge the output capacitive load.
Fall time is the time it takes for the output capacitive load to discharge. The rise and fall time are
usually measured from 10% to 90% and from 90% to 10% of the steady state value of a waveform,
respectively.

Propagation delay is the time difference between approximately 50% of the input transition and
approximately 50% of the output transition.

Measuring propagation delay using Waveform calculator

Waveform calculator can be used to perform many different measurements and transformations on
the waveforms displayed in the waveform window. This includes — computing the average of a
waveform (e.g. power) over the entire length of the simulation or in a given period of time, finding
the propagation delay of between input and output signals, or
addition/subtraction/multiplication/division of waveforms, etc.

1. Execute Tools-=>Calculator in Virtuoso Visualization & Analysis XL window. Virtuoso

Visualization & Analysis XL calculator’ window will pop-up:
F2E Virtuoso (R) Visualization & Analysis XL calculator - O X

File Tools Wiew Options Constants Help cadence

”H In Context Results DB: DmeffaIH6.?12E|1E|5IJIJ1a’simuIati0n.finver’[erfspectrea’schematicfpsfn k

vt

(J R B T [ _ ¥s . 08 ~op oot - mp -l - ip
H| it o if . ide s — opt . war vnz | L zp ”
|||g, Off _ Family _ ‘Wave |! Clip | [:!(\ nﬂ |Append nkﬁectangular n| @| >
Key ... (=1l |
T g 3 i
4 ] g
1 2 3 B (L = e fexp=]
e Lol D B | B2 g | B e | T EE R

[
E
=~
\th

X

o
@
b
e )
Function Panel JX
|Special Functions n Q
FH compare dBm  dutyCycle  flip gainkargin - iintey loadpull  peakTof
azd compression delay evmGakl  fourEval getdsciitave inl Ishift period_j
abs_jitter compressionRI deriv evmQpsk  freg groupCelay  integ narmal@G phasehd
average  convolve dft eyedperture freq_jitter  harmonic intersect overshoot phased
bandwidth cross dithh  eyeDiagram freguency  harmonicFreg ipn pavy pow
clip dZa dnl fallTime gainBwProd histogramzD  ipnVRl peak prms
[ 0 ™
Function Panel Expression Editor
status area B

13 | Trace: fout; Contest: shomedfall16/ 200105001 /simulationsinyverter’'spectre/schematic/pst, Dataset: fra
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2. Select ‘vt’. Go to Schematic editor window and click on input node ‘in’. An expression (e.g.
VT(“/in”)) will appear. Copy the expression.

syt L J it L [ L s L) 03 . op ot . mp L M . 5p
it L i ) idc s o opt o ovar . ¥Ne . Ip
|| off  Famiy _ wave | v Clip | Ty & (append B3 rectanguiar @ 6% |
Key ... 1=k q U'I'I"fin"
gl |l | /
3. In the Function Panel, select ‘Special functions’ and select ‘delay’.
Function Panel =Ed
Special Functions B Q,
P Cormpare dBm dutyCycle  flip gainkdargin - iintey [oadpull  peakTof
azd COmpression delay evmab  fourEval fetasciivave inl [shift period_j
abs_jitter compressionVRI derivy evimGpsk  freg groupDelay  inteq harmalzE phasekd
average convolve dft eyefperure freq_jitter  harmonic intersect overshoot phased
bandwidth cross dfiblhy  eyeDiagram frequency  harmonicFreq ipn pav o
Clip dZa dnl fallTime gainBwProd histogramzD  ipnYRl peak prms

4. The following window will appear. Put the expression previously obtained in the field ‘Signall’.
Do the same for output signal ‘out’ to fill in the field ‘Signal2’.

Function Panel
|Special Functions n Q

Ith
=

delay

Signall  ¥T("/in")

Signal2
Threshold Value 1 2.5 Threshold Value 2 2.5
Edge Humber 1 1 Edge Humber 2 1
Edge Type 1 either n Edge Type 2 either
Periodicity 1 1 Periodicity 2 1 =

Ok | Apply | Defaults || Close | | Help

Function Panel 0 Stack. |

Fill up the rest of the form as follows:

Function Panel =) E3
|Special Functions n Q
delay

Signall | VT("/in")
Signal2 | vT("/out")|

Threshold Value 1 06 Threshold Value 2 0.6
Edge Humber1 = Edge Number 2 =
Edge Type 1 falling n Edge Type 2 rising
Periodicity 1 1 Periodicity 2 1

Ok | Apply | Defaults | | Close || Help

Function Panel || Stack |

5. Click OK. The following expression should appear:
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s vt R o wdc M5 . 0% ~ opo_oof . mp N 5P wswr o hp
it o ) ido i . opt o war I MNE Zp Lwp . Od

L

|~ OF _ Family _ Wave |1 Clip | i!"ﬂ'l & |Append Bhﬂectangular n| {%’| =

| Key ... & X delayl?wﬂ YTI"in™, Fvaluel 0.6, Yedgel "falling”, Tnth1 2, Fid1 0.0, Pwf VT out"),
7 i Tvalued 06, Yedges "rising”, Tnthe 2, TE nil , Tstop nil, Pmultiple niII

i

o B *
2 - =g =] =)
DT B B g | s s

6. Click on Evaluate the buffer icon.

o

"+ B

4
1
I}

IIITF:"'

| %

oy

The propagation delay (in seconds) will be displayed in the window.

- vt i o wdo . Ms . 0% . op oot _ mp N o 5P ovswr o hp
it L ) idz T . opt o war I MNE P _yp [
|[o off _ Family _ Wave |v Clip | i!,.q & |Append Bkﬂectangular B| {%’| =
AN 8 %|[109.26-12

7 i 3 i
4 =

1 2 3 - —

Po =ome, m Mg | PR B s
[ (it + ‘| Q H:.EC in&sel:'t @P@ = | H!‘ [E]L! 5 %;_ f% | -

Measuring rise time and fall time using Waveform calculator

1. Open the ‘delay’ function window under Waveform calculator in the same way that you
followed for propagation delay measurement. This time both Signall and Signal2 will be
VT(“/out”).

2. Threshold value 1 and 2 should be 0.12 (10% of 1.2 V supply) and 1.08 (90% of 1.2 V supply)
respectively for 10% to 90% rise time calculation. These values should be swapped for fall time
calculation.

3. For rise time/fall time calculation, both the Edge numbers must be the same.

4. The Edge types should be rising for rise time calculation and falling for fall time calculation.
Example: Rise time calculation of rising edge 2 for an inverter:

Page 23




EEE 4134 VLSI I Sessional

delay
Signall | VT{"/out”) - -
Signalz | VT{"/out”) [~ |
Threshold Value 1 012 Threshold Value 2 1.03
Edge Humber1 2 Edyge Humber 2 2
Edge Type 1 rising n Edge Type 2 rising n E
Periodicity 1 1 Periodicity 2 1
Humber of occurrences |single n Flovprint vs. frigoger [=)
Start1 0.0
Start 2 nil Start 2 relative to trigger n!

OF | Apply | Defaults | Cloge Help

5. Click OK after filling in the form as shown above. The following expression should appear:

syt R o vdc M5 . 0% ~ op oot . mp N L~ &p
it i o idc s . opt o war i . EZp
| off & Famiy _ wave | Clip | Tln o [append R Fectangular B

Key ... 8 x| 709 9612
¥ i q {
4 = 4] =
1 g i - (=]
Po H mER. o Mese | P B
0 s e al D Bl n | BB g | B Y YRR R 6

Process corner Simulation

Re-simulate the circuit using Fast Fast (FF) corner. For this purpose execute Setup-=>Model
Libraries. Go to section and select FF_slv. This will select the fast corner model. Re-simulate the
circuit and find propagation delay.

f}( spectrel: Model Library Setup — O
|Madel File | Section |
B Global Model Files
b o fech/processfgpdk090/Mmodelsdspectre/gpdk090_mos . scs FF_slv

el |=Click here to add model files=

Also do the same for SS, FS and SF corners.

Power Measurement using Waveform Calculator

In this tutorial, we will compute the average power consumed in a circuit for the duration of
transient simulation window.

1. To do this, make sure that before running simulation you select the Outputs ->Save All option in
ADE L window. ‘Save Options’ window will appear. Under ‘Select power signals to output
(pwr)’ option, put a tick mark in all option. Click OK.
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Save Options

Select signals to output (save) _ none _ selected _ Ivlpub _ Ivl o allpuh _ all

Select power signals to output (pwr) _ none _ total _ devices _ subckts ) all

2. Then simulate the circuit as usual, by executing Simulation >Netlist and Run.
Execute Tools = Result Browser in ADE L window. ‘Result Browser’ window will appear to the
left side in “Virtuoso Analysis and Visualization XL’ window.

Browser 7 E X
| ] mylib inverter schematic £
Append n = cient Respons sataprls 14:14:11 2017 1

o | ' c—

onfinvenen’spectrefschematicfpsfn

= finverter/spectrefschematic/pst

Signals Search

[T tran

[ tranop

L model

L1 instance

[T output

[0 designParam‘fals
[T primitives

[0 subckts

L3 wariables

n S i) 700 an.n 90.0 100

W vl »

3. Double-click on tran. From the signals list, double-click on :pwr
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Browser BE8
Append |~ ; »
A X | {E ] B

]nfinver‘[erfspectrefschematicfpsfﬂ [

EH- B ..verer/spectre/schematic/pst |
G- [ tranCp
G- £ model
G- (13 instance Ly
B [ output
G- (B designParamals
H- [ primitives

Signals Search

® in
MrAD:pwr @ out

& Fra0per & vdd
@ _vinp
@ _vwddip

4. The waveform display window will show the “:pwr” (the instantaneous power consumed by the
whole circuit) along with “in” and ‘out’ signals.

Browser irall=Ilb. . :
— ‘ K1 mylib inverter schematic £
n.
dnend - bl T2zt Response Gatépr1s 14:14:11 2017 1

A % | {= | B

0nﬂnvenerfspectrefschematicfpsfn I

- kB . dinvererspectresschematic/pst

B (13 tranOp

Bt [ model

B [ instance

B [ output

B [ designParamyals
B[ primitives

3 subckts

B B3 variables

Signals Search

g PRAD: ey

@ Pr0pwr

@ _vinp

@ _wvddip
in

& out

& wvdadl

— 100 200 300 40.0 S0.0 GO0 70.0 &0.0 a0.0 100
Wl [ ] i

5. Now, open Waveform calculator window. The calculator window appears. Make sure the
“Wave” and “Clip” options are selected.
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e et [ e RO oende. TG wse Caias  [iCaon: Lot L Jimp
m it @ . idc @ _ opt _ wvar
|l off _ Family @ wave | Clip | f:]/\ &4 |Append n

6. Now switch back to the waveform window and left click the mouse once on the power
waveform. Then switch back to the calculator window. The buffer window should be filled in as

follows:

Wt M o wdc o ¥E 03 . op ot . mp . Mn -
m it L if . idc s L opt o ovar ] v -
|||U Off _ Family & Wave |£ Clip | [:Jﬁ S |Append Bkﬂectangular |
LAY EPEJ getDataI":pwr" Tresult "tran”

I a8 |8 i
4 || 5 || B :

i i e ey n e g gy | Be e | B S
Coe A B B g e e YR

7. Now select ‘average’ from ‘Special Functions’ Menu.
| Function Panel
JLSpeciaI Functions B Q
Fr dutyCycle iinteg psd tangent
azd 211G A ] inl padbb thid
abs_jitter evmizpsk inteq pstddey unityGainFreg
averape eyedpeture  intersect pzhode Yalue
bandwidth eyeliagram  ipn pefilter wiavel siWave
clip fallTime ipny Rl riseTime Hmax
compare flip [oadpull Fms =min
COMpression fourEval [shift rmskoise =val
compressionRl freq normal@G  rms_jitter Y A

8. The buffer will now look like the following one:

LAY EEJ aueragelgetData(":pwr" Tresult "tran"jl
7 i & i

9. Click on Evaluate the buffer icon and the average power dissipation in that time window will

be displayed (about 1.838 uW in this example).
LKey ..  @X|[4535c5

QUESTIONS:
Why does delay occur in logic gates? Why do logic gates consume power and when do they

consume? What is the effect of delay on logic circuit design? What are the designer’s goals?
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Appendix: Cadence Virtuoso® Schematic Editor L Shortcuts

Shortcut key Tasks performed
w Add a wire
i Add an instance
p Add a pin
I Add label to a wire
e Display options
q Select an object and press q to open ‘Edit
Object Property’ dialogue box
[ Zoom out
] Zoom in
c Copy
m Move
u Undo
Shift+u Redo
f Fit the entire schematic in the window
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EEE 4134 VLSI | Laboratory
Lab 2

Parametric analysis of DC and transient simulation of an inverter and Symbol
creation

Objectives:
e To learn how to perform parametric simulation in ADE L
e To learn how to create symbol view from schematic view

Parametric Analysis in ADE L: DC simulation

1. To open the schematic of inverter, execute File=>Open in CIW. In the ‘Open File’ window,
select the inverter schematic from the list. Click OK.
X Open File — O x

File
Library  mylib [~ —

inverter

Cell inverter
L=t schematic
Type schematic

Browse

s -

Application
Openwith  (Schematics L B

_ Abbays use this application for this type of file

Cpen for ® edit o read

Library path file  /home /£a1116/120105001 /cicfcds. 1ib

Cox DTS

2. Schematic editor window will open. Execute File=> Save a copy. In the following window,
change the name of the cell to inverter2. Click OK. Close the schematic editor window and open
the inverter2 cell from CIW.

I}{ Save a Copy — O x
Library Mame mylih

Cell Mame inverter?

e schematic

_Cancel ) _thlp_

3. This time we will perform both DC and parametric simulation at the same time on inverter
schematic. We will obtain the transfer characteristics of inverter from DC simulation and by
varying the width of the PMQOS transistor; we will observe its effect on transfer characteristics.
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Select the PMOS transistor in the schematic editor window, click ‘q’ and ‘Edit object properties’
window will open. Place w under ‘Total Width’ and press tab on keyboard. The ‘Finger Width’
field will be automatically changed as follows:

COF Parameter Walue Display
kodel Marme gpdk090_pmoslv
bAultiplier 1
Length 1000 M
Tatal Width w M
Finger Width 1Par ("w")  iPar("fingers") M

4. Place symbol of an instance vdc from analogL.ib to the schematic. In the ‘DC voltage’ field,
type vin and press tab on keyboard.

X Add Instance — O *
Likarary znalogLihb Erovese

A ——
Cell wdc
Wiew
Mames

» Add Wire Stubs at:
 all terminals & registered terminals only

Array Rows 1 Columns 1

42 Rotate Ak Sideways ﬁ Upside Down

MHoise file name

Mumber of noisesfred pairs 0

OC voltage vin ¥

5. Connect the voltage source between ‘in’ and ‘gnd!’.

Now place another instance of vdc on the schematic, in the ‘DC voltage’ field, put 1.2 and connect
it between vdd! and gnd!

The final schematic should look like the following:
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! :_ ] i"ﬂ 0 _-. 1 '-.,.-".'

Click Check and Save.
6. Execute Launch=> ADE L and setup Model Library to gpdk090 _mos.scs and section to
TT _slv
7. Execute Variables = Edit and ‘Edit Design Variables’ window will open.
X Editing Design Variables -- ADE L (3) — O *

Selected Wariahle DBl Wk

Mame | YWalue
Mame |

Walue (Expr)

add | Delete Change

[ et Clear Find

Cellview Variables | Copy From | Copy To

m _Lancel . Apply o Apply & Run Simulation . Help
8. Select ‘Copy From’. You will see ‘w’ and ‘vin’ appear in the ‘Design Variables’ window.
Click on ‘w’ and in ‘Value (Expr)’ field, put a default value of 480n. Click Apply. Similarly click
on ‘vin’ and in ‘Value (Expr)’ field, put a default value of 0.6.
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X Editing Design Variables -- ADE L (5) — O >
selected Variable Design Yariables
_ Hame Value
e - : B00m |
5 W 480n
Value (Expry 0.6 £
Add | Delete | Change
L o g F &
M et Clear | Find
L # s A
Cellview Variables | Copy From | Copy To —
L A &
Cancel Apply Apply & Run Simulation Help
Then click OK.

9. Execute Analyses= Choose and in the ‘Choosing Analyses’ form, select dc. Click on ‘save dc
operating point’.
10. Under ‘Sweep Variable’, select ‘Design Variable’ and click on ‘Select design variable’.

X Select Design Variable = O X

win
W

icancel Help

Select ‘vin’ and click OK.

11. Under ‘sweep range’, select ‘start-stop’ and put a start value of 0 and a stop value of 1.2.
Select ‘Sweep type’ to be ‘linear’ and ‘Step size’ to be 0.01. Click OK.
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X Choaosing Analyses -- ADE L (5) — O ¥
Analysis  tran & e WA AC  hinize

o Af s SENS « docmatch o acmatch

— sth w Pz - 5P — envlp

o pss . pac — pstb — pnoise

—_ — PEp — Hpss — qpac

w Opnoise o gt o gpsp wst hh

. hhac . hbnoize . hhbsp

DC Analysis

Save DC Operating Point L
Hysteresis Sweep

Sweep Yariable

__ Temperature

 Design Variable Yariahle Mame  win

_ Compaonent Parameter Select Design Yariahle

kodel Parameter

Sweep Range

& Start-Stop

~ Center-Spah

Start 0 Stop 1.2

Sweap Type
& Step Size

i 0.0y
L
M o Mumber of Steps

Add Specific Points

Enabled Oiptions...
— —_

m cancel Defaults Apply Help

12. Execute Outputs = To be plotted and select ‘out’ pin on the schematic.
ADE L window will now look like the following:
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i ¥ ADEL (3) - mylib inverter2 schematic — O x
Launch Session Setup Analyses Variables OQutputs Simulation Results Tools Help cadence
i - =
IR AR IR =N N =
. . Analyses al=t
Cesign Yariahles Eac
Type | Enahle| Arguments e
_ Mame | Walue 1 dc v t01.2 10m Linear Step Size Stark-Stop
1 vin BO0M . m
< 480n
_ ||::4
#
8 s - O
Outputs edll=Tkd @
o MamesSignal/Expr | Walue | Plot| Save| Save Options 1
1 out W Al Ivu_u
< il K <l il p
b _— ) . q -
= Select on Schematic Outputs to Be Plot| P10t after simulation: futo @ Piotting move: Replace g

11(20)\ Load State ... | Status: Selecting  outputs to be plotted.. | T=27 C | Simulator: spectre |

13. Execute Tools=> Parametric Analysis. ‘Parametric Analysis’ window will open.

Zr. Parametric Analysis - spectre(4): mylib inverter2 schematic — O et

File a&nalysis Help cadence

Il Ready

- E ‘% | @ ® U @ v|Hun Mode: Sweeps & Ranges =| @. 'm Ui |
Wariahle | Walue | Sweep? | Range Type | Start Point| End Point | Step Mode | Step Walue

aAdd Yariahle... v From/Tao Auto

< I

&1 | Delete selected rows
14. Click on ‘Add Variable’. From the drop down menu, select ‘w’. Put From: 240n, To: 720n,

Step Mode: linear steps and Step Size: 120n.

Wariahle | Walue | Sweep? | Range Type |  From | To | Step Mode | Step Size |
W 4a0n v FromsTo 240n 720n Lingar Steps  (120n
|

Click on ‘Run selected sweeps’ icon to start simulation.

The simulated waveforms will be displayed.
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1 mylib inverterz schematic [

wed AprS 14:3

[ufis] o1 0.z 0.3 0.4 0.5 0.6 0.7 0.8 0.8 1o 11 1z

These transfer characteristics can be further explored to find Noise margin, and inversion voltage
for different widths of PMOS.
15. This parametric analysis option can be saved for later use by clicking on the save icon.

In the following window, give a name to the configuration file and click Save.
X Save as Parametric File — O *
Loak in: 9 shome/falll 67120105001/ cic n © B [ 8
Comput rame -~ | Size |Type |Date Modified |
B 120105 |F9 .cadence Folder 30 Mar ..3:35:43
B mylib Folder 5 &Apr 2. 4:30:52
" LIl L

File name: inverers
Files of type: |Parametric Files (.il) n _tancel

16. Also save the state of the ADE L window.

Parametric Analysis in ADE L: Transient simulation

1. For parametric analysis of transient simulation, open the schematic of the cell inverter from
library mylib and save it as inverter3. Open the schematic of the cell named inverter3.
2. Change the ‘Total Width’ of PMOS to “w” as you have done before. Click Check and save.

Page 35




EEE 4134 VLSI I Sessional

prnos Ty ‘

nmos 1y

3. Now, launch ADE L, and Setup Model Library, Analysis type, Stimuli and Outputs to be
plotted in the same way as you have done in Lab 1.

4. Then execute Variables 2Edit. Select ‘Copy From’. “w” will appear under ‘Design Variables’,
select it and enter a default value of 480n under ‘Value (Expr)’ and click OK.

Cesign Variahles

Mame |
480n

= |

YWalue

fnalyses 78%]
Type | Enable| Arguments :;':m
1 tran » 0 Z00n E[I]
o=
®

- o

Outputs 7 5[]

HamefSighal/Expr Value Save Save Dptmns |

2 nut allu .

5. Now, execute Tools- = Parametric Analysis. Select ‘w’ from the ‘Add varlable list, and fill in

the rest as follows:

Wariahble | Walug | Sweep? |
W 4a0n

Click on ‘Run selected sweeps’.

L

Range Type | From | Ta | Step tode | Step Size |
From/To 240n Feln Linear Steps 1200
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6. From the waveform display window, change the time scale and observe a specific transition from
high to low or low to high.

V1 mylib inverter3 schematic £

wed Apr 5 14:55:14 2017 1

You can clearly see the effect of changing width on the inverter performance.
7. Let’s find the delays for this transition. Open Waveform calculator and fill in the form as
follows for calculating the delay for this transition.

delay
Signall | VT("/in" [~ .
Signalz | VT("/out”) B
Threshold Value 1 0.6 Threshold Value 2 0.6
Edge Mumber 1 1 Edge Humber 2 1
Edge Type 1 [rising n Edge Type 2 falling n =

Click OK and click on ‘Evaluate the buffer and display the results in a table’ icon.

L&

The results will be displayed in a table:
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% Virtuoso (R) Visualization ... — O >

File Edit Miew Tools Help cadence

& & | 9 I8

@' delay (Pl WTvin", Tvaluel . [E)

N Wy | delay{?..le nil} | a
1 240.0E-9 -2921E-12
2 J60.0E-9 -174.5E-12 =
3 480.0E-9 -67.91E12
4 G00.0E-9 -19.98E-12 L
5 720.0E-9 38.04E-12 |

You can see that some of the propagation delays are negative. Can you explain why? Also notice
that propagation delay increases with the width of PMQOS transistor for a falling transition in
inverter output. Can you explain why? What will happen during a rising transition?

Symbol Creation

In this section, you will create a symbol for your inverter design so that you can use this symbol
view for the schematic in a hierarchical design. In addition, the symbol has attached properties
(cdsParam) that facilitate the simulation and the design of the circuit.

1. Open the schematic of the cell inverter from library mylib. Save a copy named INVX1. Change
the width of the PMOS transistor to 240n.

2. In the schematic editor window for INVX1, execute Create =>Cellview =From Cellview.
‘Cellview from cellview’ window appears. Click OK.

X Cellview From Cellview - O X
Libirary Mame mylih Eroyse
Cell Mame INVEL

From View Name  schematic [Kg

To Yiew Mame symbol

Tool / Data Type  (chematicSymbol [~ |

Display Cellview

Edit Options L

<

m _ Eancel . Defaults  Apply | Help
In the ‘Symbol Generation Options’ window, you can choose the location of the pins.
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Library Mame Cell Mame

iy lih INVEL

Fin Specifications

Left Pins in
Right Pins out
Top Pins

Bottom Fins

Exclude Inherited Connection Pins:

& Mone &l Only these:

Load/Save __ Edit Attributes

Edit Labels

EEE 4134 VLSI I Sessional

— O *
Views Mame
symbol
Attributes
List
List
List
List

Edit Froperties

_Cancel ) _&pply )\ Help
Click OK. Symbol Editor window will open.
E Virtuoso® Symboel Editer L Editing: mylib INVX] symbol — O *
Launch Eile Edit Wiew Create Check Options Window Help cédence
N # 0@ xX QDO Ko 7 r R A "
e Basc PE QD IR = @04 @ / ® [ &

Havigator 78 x|

" Diefault n
Q B-

ame =

= THW
e, out
LB NP
LB outP_ 1

Property Editor 78X

mouse Lo mousesingleSelectrt)
21 | =
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3. Click Delete icon in the symbol window, delete the outer red rectangle, green rectangle and
instanceName property.

4. Execute Create ->Shape=*polygon, and draw a shape similar to triangle. After creating the
triangle, press Esc key.

5. Execute Create *Shape =>Circle to make a circle at the end of the triangle. You can move the
pin names according to the location.

6. Execute Create =»Selection Box. In the ‘Add Selection Box’ form, click ‘Automatic’.
X Add Selection Box — O *

Drawe the rectangle to define the selection box
ar Click helow to create it automatically.

Sutomatic

@I Cencel | Help
A new red selection box is automatically added.
7. After creating symbol, click on the save icon in the symbol editor window to save the symbol. In
the symbol editor window, execute File 2Check and Save. Then close the symbol editor window.

QUESTIONS:

What is the effect of load capacitance on delay and power consumption? What will happen to delay
and power consumption if sizes of transistors are increased? What is the effect of transistor sizes on
noise margin level? What is the significance of inversion voltage? What is the effect of process
corners on delay and power consumption?
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EEE 4134 VLSI | Laboratory
Lab 3

Layout of an Inverter using Virtuoso L

Objectives:
e To create a layout view of the basic inverter circuit from scratch in Virtuoso Layout Editor
e To design the layout keeping basic design rules in mind
e To design cell layout of a constant height for use in hierarchical design

Introduction to Layout, DRC and LVS

Layout is representation of a circuit in terms of planar geometric shapes (e.g. rectangles, polygons)
showing the patterns of metal, polysilicon, oxide, or diffusion layers that make up the components
(resistors, inductors, capacitors, transistors) of the integrated circuit.

When using a standard process (e.g. 45nm, 90nm or 180nm process available in our lab), the
behaviour of the final integrated circuit depends significantly on the positions and interconnections
of the geometric shapes due to parasitic resistances and capacitances contributed by them. While
designing a layout, designer must keep in mind performance (e.g. power-delay product) and size
(area occupied by the chip) criterion.

While designing digital circuits, one usually follows an ASIC design flow, where, the height of
standard cells that are used is the same throughout the cell library, but their widths must vary
according to their logical functions and drive strengths. The following figure shows a generalized
standard cell height concept:

P

| VDD BUS |
| P-TYPE TRANSISTORS |

DIFFUSION SPACING Cell Height
N-TYPE TRANSISTORS ‘

| GND BUS oy

Although we will follow a full-custom IC design flow, we will maintain same cell height
throughout our cell library.
The generated layout must pass a series of checks in a process known as physical verification. The
most common checks in this verification process are:

e Design Rule Checking (DRC)

e Layout Versus Schematic (LVS) checking

e Parasitic extraction and post-layout simulation

Design Rule Check (DRC):

Design Rule Checking (DRC) is the process that determines whether the designed layout of a
circuit satisfies a rules specified by the process being used.

Design Rules are a series of rules (e.g. area, width, overlap, enclosure, extension, spacing) provided
by semiconductor manufacturers which are specific to a particular semiconductor manufacturing
process. Design rules specify certain geometric and connectivity restrictions to ensure that the
process can fabricate the device properly.
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Layout versus Schematic (LVS) Check:

The Layout Versus Schematic (LVS)is the verification step to determine whether a
particular integrated circuit layout corresponds to the original schematic or circuit diagram of the
design. A successful Design rule check (DRC) ensures that the layout conforms to the rules
designed/required for faultless fabrication. However, it does not guarantee if it really represents the
circuit we desire to fabricate. This is why an LVS check is used.

Layout design using Virtuoso Layout Suite L Editor

1. Invoke Virtuoso Layout Suite L Editor from the CIW by executing File >New 2>Cellview.
The ‘New File’ form appears. Fill it in as shown in the figure below:
Cell: INVX1, View: layout. Click OK.

X New File — O X
File

Library mylib B
Cell THVEL|

Wi layout

Type el [~
Application

Open with Layout L ﬂ

_ Abways use this application for this type of file

Libirary path file
Jhome /£21116,/120105001 /cic/eds. Lik

_Cancel ) _tlp_

2. Click ‘Always’ if the following window appears before Layout window appears.
X MNext License — O >

ey (cLic-23) License Yituoso_Layout_Suite_L ("933300" is not available to run Layout L.
\,) Would you like to try checking out the license Viruoso_Layout_Suite_XL ("35310") instead?

Yes Mo | Always - Mever | Help

L.

The following window of Virtuoso Layout Suite L Editor will appear.
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f2£ virtuoso® Layout Suite L Editing: mylib INVX1 layout - O X
Launch File Edit ¥iew Create Vetify Connectivity Options Tools Window Assura Optimize Help cadence
= ¢ lde O X RO RG] » [ » |crs B &
|% -s,.,.E g = i?§1%|kﬁ| L] E| » || (F)Zelectn Sel(M)0 Selfy0 SelfO}0 |X -13.5950 ¥ 7.2850 ¥ »
Palettie FIE (X ——
Layers & X
o Walid _ Used _ Routing
Q B-
I el draing n
a0 MW a5 M5 ’
Hame | Wis | Sel |
+|[ = +] -
Layer |Pu.| | 5|
R drus w W=
Cixide drw W 1\_’
W Oxide_the drw o &
Paly drw W W
B Fimp L
[ hvt dry W W
] irnp dry W W
[ Pt dry W W
W izt dry W W
W siFrot dry W W
[ ] Cont dry W W
Objects &)X
OhjE[:tS | \"'| 3 A
L Instances ¥ W=
H . b
é----PInS W
b Wiag ¥ ¥
Ohjects Grids
iimouse L: mousesingleSelactPid) b deflew) R: _IxHitdouseFPoplp()
3(5) | Redo | cma: |

On the left side of the window, you will find a panel called ‘Layers’. This panel is divided in three
main categories which are: layer color, layer name and layer purpose. The details are described in
the table below:

Color Matches the color in the Editing window. Each layer has its own color and pattern.

Each layer has two colors associated with it: a fill color and an outline color. These
colors can be changed to fit your taste by editing the technology file.

Name The type of layer (Nwell, Oxide, Poly, Metall, etc)

Purpose In gpdk090 the only purpose classifications are: drw = drawing, slot = slot
Drawing is used in layout, slot is used to create a hole for metal stress relief

Verify that the layers display corresponds to the gpdk090 layers shown in the GPDK 90 nm Mixed
Signal Process Specification manual (gpdk090 DRM.pdf).

3. Before starting to design layout, you need to set the layout display configuration. Execute the
following in the Virtuoso Layout Editor: Options=>Display or press ‘e’ on keyboard. Configure
the form as shown in the figure below: You have to set the following parameters only:
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Display Controls

W

L

kaximum Drag Level
Faximum Mumber of Drag Figures
Scroll Percent
Instance Drawing kode

Fath Display

Open to Stop Level

Axes

Instance Criging
EIF Surround
Fin Mames

Dot Pins

Met Expressions
Stretch Handles
Yia Shapes
Dynamic Hilight

Dragged Object Ghost
Traversed instance EBox

EEE 4134 VLSI I Sessional

Minor spacing 0.01
Major spacing 0.1

X snap spacing 0.005
Y snap spacing 0.005
Display Levels: Stop | 10

— Mets

Access Edges
Instance Pins
Array lcons
Label Origins
Use True BBOx
Cross Cursar
Row Mame

Row Site

<

True Colar Drag

__ =election Hint

3z

saa

25

LEIEIDx

LEh:urders and Centerlines n

Set LPP wisihility (D0 nat check validity n

Show Mame Of o instance &

array Dizplay

2
»

L

Full
Border

Source

master . hoth

Display Levels

start 0

Stop 10|

Transparent Group

— | X
Grd Controls
Type @ none o dots o lines
Dim Major Dots
rinor Spacing 0,01
rajor Spacing 0.1
¥ Enap Spacing 0. 0os
Y Snap Spacing 0. 005
Filter
Size B Style e ity n
Snap Modes
Create arthogonal n
Edit arthogonal n
Dimiming
Enable Dimming L
SCDPE nane
Dirn Grid Lines

Automatic Dimmirg

Ditn Intensity:
al

Dim Selected Object Content

True Color Selection anly

& Cellviews o Library o Tech Library o File

Save Ta
> L

wf cdsenwy

Load Fram

o

Bronwse. .

Delete Fram
L >

Defaults Help

Apply

4. Now we are going to build the layout of the inverter. An inverter has an NMOS and a PMOS
transistor. First we will build an NMOS transistor.
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Layout of NMOS inverter consists of oxide, Nimp, Cont and Poly layers. Study the rules of these
layers and calculate the minimum size of the Poly, Cont, Oxide and Nimp layer to create an NMOS

transistor.

The rules related to the NMOS transistor can be summarised as follows:

Contact size

0.12 um x 0.12 um (Fixed)

Poly width (Minimum)

0.1 um (Fixed MOS gate length)

Contact to poly spacing (Minimum)

0.1 um

Contact to oxide enclosure (Minimum)

0.06 um

Poly/Nimp extending from oxide (Minimum)

0.18 um (gate side enclosure)

Nimpenclosing oxide (Minimum)

0.14um (enclosure other than gate sides)

Minimum Metal 1 width

0.12 um

Maximum Metal 1 width

12.0 um

Minimum Metal 1 to Contact enclosure

0.06 um (on at least two opposite sides)

The following figure illustrates some of the design rules mentioned above:

| Io.wy |
0.6 ,uI « - Oxide

| Cont|_ A IS L
i ) o N | ‘
0.14y 0.1u| & 01u X 0144
‘ & ,,,,,,,,,,,,,,,,,,,,,,,,,,,,,, 0124 =
Nimp/Pimp IO.lS,u

Now study the PMOS transistor structure in the GPDK 90 nm Mixed Signal Process Spec. The
PMOS transistor consists of Oxide, Poly, Pimp, Cont and Nwell layer. Study the rules of these
layers and calculate the minimum size of Poly, Cont, Oxide, Pimp and Nwell layer to create a
PMOS transistor. The rules related to PMOS are same as NMOS except the there is an additional
layer, the Nwell, whose rules are as follows:

Minimum Nwell width 0.6 um
Minimum Nwell spacing to Nwell (same potential) 0.6 um
Minimum Nwell spacing to Nwell (different potential) 1.2 um
Minimum Nwell spacing to N+ active area 0.3 um
Minimum Nwell spacing to P+ active area 0.3 um
Minimum Nwell enclosure to P+ active area 0.12 um
Minimum Nwell enclosure to N+ active area 0.12 um
Minimum N+ Active Area to P+ Active Area Spacing 0.16um
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Now we start building the NMOS and PMOS transistor layout. Look at the LSW and find the
current drawing layer.

5. Click on the following icon in Virtuoso Layout Suite L Editor window so that it notifies you
anytime you make a violation of any design rule. When clicked, it will show ‘DRD Notify ON’.
DRD stands for Design Rule Driven.

!-—_;l

6. Select ‘Cont (drw)’ (contact) layer from the ‘Layers’ panel and draw a rectangle of ‘Cont
(drw)’ layer using Create »Shape 2*Rectangle or simple pressing ‘r’. Press ‘ESC’ to stop ‘Create
rectangle’ tool. In gpdk090 technology, Cont layers must be of dimension 0.12 um x 0.12 um. So,
if your rectangle is not of that dimension, click on the rectangle, press ‘q’. In the following
window, check if the criterion has been met and change ‘Width/Height’ if required.

X Edit Rectangle Properties - O X
< = Apply Comman
Attribute Cannectivity Paratmeter Property ROD
e [t Jo] [ Lo
Left -89z Bottom 1.935
Right -9 Top 2.055
Width 01z Height 0tz

m ._Cancel__ ) .-‘-‘«pply__ __Help__

Contact to poly spacing must be 0.1 um in this technology and the channel length of
NMOS/PMOS in our design is 0.1 gm. So, we need a minimum space of 0.3 um between the
contacts at source and drain.

7. Press ‘K’ to invoke the ‘ruler’ tool. Use it to measure lengths whenever needed. To copy, press

‘c’. After placing two contacts, the layout looks like this:

8. Now, contact to oxide spacing is minimum 0.06 um. So, draw a rectangle of ‘Oxide (drw)’
layer so that it covers both the contacts and extends from each side by 0.06 um.
While drawing this, you will see Design rule violations when they are committed.
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0.1 0.1k oz 0. 25

SRR IS TS B
minExtensiulnDislance 0.06

minArea 0.06

005008

060::05

10. Now we will draw ‘Nimp (drw)’ layer, which must extend from the oxide layer by a minimum
of 0.14 um. First, draw a rectangle and then extend it to meet design rules. Use stretch tool by
pressing ‘s’. Layout will look like the following:

11. Now, copy it and create another copy of all these layers by selecting all and pressing ‘C’.
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12. Click on the ‘Nimp (drw)’ layer of the copy in the upper portion of the layout and press ‘q’ to
edit properties. From ‘Edit Rectangle Properties’ window, select ‘Pimp (drw)’ layer under
‘Layer’ option. Click OK.

X Edit Rectangle Properties — O >
= = Apply Comman
Attribute Connectivity Farameter Property ROD
Layer |.Pimp ||:lrw H Layer Filter
Lett -1012 Bottom a6
Right -9.18 Tap 41z
Width 0.94 Height 0.4z

_ancel . Apply | Help

13. With more metal layers available in today’s silicon processes, using the routing approach, such
as first metal traverse vertically and second metal traverse horizontally, would be advantageous in
standar cell physical design. Using this method, the second layer (e.g. Metal2) can be used for
power and ground routing over internal standard cell transistors. In standard cell layout, it is
preferable to use firt conducting layer, such as Metall, as much as possible to make internal
connections of NMOS and PMOS transitors within the cell. If there is a nedd to use other
conducting layers, such as, Metal2, use of such layers must be kept to a minimum. It is desired to
use first routing (e.g. Metall) layer for standard cell ports.

Our cells will have a height of 5 um. Place the two parts (NMOS and PMOS) 2 um apart, and
create a ruler so that the cell height can be checked whenever needed and the separation between
the NMOS and PMOS can be maintained properly. Now, the layout will look like the following:
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14. Next, draw a ‘Poly (drw)’ path by selecting ‘Poly’ layer from the ‘Layers’ panel and pressing
‘p’ to invoke ‘create path’ tool. This layer must be of 0.1 um in width and in between the two
contacts, extending from the oxide layer by 0.18 um (at least, on both sides). After placing the
‘poly’ gate, the layout will look like the following one:
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15. Now that you know most of the shortcuts and layers, draw contact for body terminals for
NMOS and PMOS. These portions should consist of Cont, Oxide and Nimp (for body of PMOS) or
Pimp (for body of NMQOS). Check DRD notifications for design rule violations. The following
figure shows a Psubstrate and an Nwell contact. The measurement dimensions are shown only on
the left one, as they are same for both contacts.
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16. Connect the Drain regions of the NMOS and PMOS. Also connect the source of both MOS’s to
respective body terminals using ‘Metall (drw)’ layer. Connect the drains of the MOS’s using
‘Metall (drw)’ layer.

17. PMOS should be in ‘Nwell (drw)’. So draw an ‘Nwell (drw)’ rectangle surrounding both the
PMOS and the body contact for PMOS. The layout will look like the following:
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18. Now, we have to place pins. The gate is in ‘poly (drw)’ layer. Let’s bring it to ‘Metall(drw)’
layer by extending the ‘Poly (drw)’ layer, creating a contact between ‘Poly” and ‘Metall’ layer by
pressing ‘0’ to ‘create via’ and selecting ‘M1 _POV’ under ‘via definition’ and placing it on

layout. _
X Create Via = O d
fMode ® Single _ Stack o Auto
Options _ Compute From Shape(s
p p pels)
Met Mame |
_ Create as ROD Ohject Mame wial

Yia Definition k1 _POw n \Ij Standard ¥ia / gpdk030

Save Wia Variant

System User defined Cut pattern Array, pattern

Reset Parameters to .. n

Justification centerCenter |3 ¥ o0 ¥oo0
Cut
CutClass  Nane Width 012 3% Length 012

Rows 1 B Row Spacing 0.14
Columns 1 B ;-}’ Column Spacing 0. 14 ;-}’

Enclosures
» Compute Show Enclosures

=1 otate ideways = Upside Down
Hh Rotate | | Ak sid || *qUpside Down |

m Cancel Help

19. Also draw a ‘Metall (drw)’ rectangle on the via, because the default Metall rectangle area is

less than the required minimum.
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minfrea 0.07

20. Now, Execute Create -=2Pin to create pins for vdd!, gnd!, in and out.
For in, vdd! and gnd! select ‘input’ as ‘I/0O type’ and for out select ‘output’ as ‘I/0 type’. Now,
draw rectangles on the Poly-Metall via for ‘in’ pin, PMOS source-to-body ‘Metall’ connection
for ‘vdd!” pin and NMOS source-to-body connection for ‘gnd!” pin. For ‘out’ pin, draw the
rectangle on the Metall layer connecting the two drains of MOS’s.
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X Create Pin — O x
hode & Manual o Auto

Connectivity & Strong o Weak

Terminal Mames in wdd! gnd! — Fhysical Qnly

— Keep First Name XPitch 0 Y Pitch 0

__ Create Label Dptions...

_ Create as ROD Object

Mame rectl
Fin Shape & rectangle o dot o polygon o circle
IFC Type & input o ooutput o inputCutput o switch

w jumper o unused o tristate

Snap Mode orthogonal n

Access Direction o top & hottom o left & right

M oany _ naone

m izancel Help

You may add label to pins.
21. Finally, add Metal2 paths of 0.5 u width for power rails and connect them to power nets in

Metall by using Metall to Metal2 via by invoking ‘create via’.
The final layout will look like the following:
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QUESTIONS:

What is layout design? What rules a designer must keep in mind while designing layout? Why does
DRC rules are provided by the foundry? What principles in layout designing are best practices for a
designer?
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Appendix A (Shortcut keys for Cadence Virtuoso ® Layout Editor L)

Shortcut Key Tasks performed
f Fit display to window
r Draw rectangle
Edit property of an object
Makes a min width path of the layer
selected in LSW
Ctrl+a Select all
Ctrl+d Deselect all
Cc Copy
m Move
S Stretch side of a rectangle
K Invoke ruler tool
Shift+k Delete all rulers
[ Add an instance
u Undo
Shift+u Redo
e Display options
0 Add via between layers
I Create a label
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Appendix B (gpdk090 Design Rules Guide (Abridged Version for VLSI-I Lab))
Terminology Definitions

Spacing - distance from the outside of the edge of a shape to the outside of theedge of another
shape.

Enclosure - distance from the inside of the edge of a shape to the outside of theedge of another
shape.

Overlap - distance from the inside of the edge of a shape to the inside of the edgeof another shape.

Butting - outside of the edge of a shape touching the outside of the edge of anothershape.
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Appendix C (Some Most Commonly Violated Design Rules for gpdk090 technology)

Description Value,
(For metals k=2 to 6, for vias k=1 to 6) 9\#12%%2
applicable
Minimum oxide (active) area 0.06
Minimum 1.2V N/P Channel gate length 0.1
Minimum poly interconnect width 0.1
Minimum gate/poly interconnect space 0.12
Minimum N/P-channel gate extension beyond active area 0.18
Minimum poly interconnect to related/unrelated active area space 0.1
Minimum poly interconnect area 0.1
Bent gate is not allowed
Minimum N+/P+ implant width 0.24
Minimum N+/P+ implant space 0.24
Minimum N+/P+ implant to active area enclosure 0.14
Minimum N+/P+ implant to gate side enclosure 0.18
Minimum N+ to P+ active area (inside Nwell) spacing 0.16
Minimum N+/P+ implant area 0.15
N+ implant is not allowed over P+ implant
Minimum P+ to N+ active area (outside Nwell) spacing 0.16
Maximum and minimum Contact width/length 0.12
Minimum Contact to Contact spacing 0.14
Minimum Contact on Active Area to gate spacing 0.1
Minimum gate Contact to Active Area spacing 0.12
Minimum Active Area to Contact enclosure 0.06
Minimum Poly to Contact enclosure 0.04
Minimum Poly to Contact enclosure on at least two opposite sides (end of line) 0.06
Contact on gate is not allowed, Contact must be covered by Metall and active
area/poly
Minimum Metal 1 width 0.12
Maximum Metal 1 width 12
Minimum Metal 1 to Metal 1 spacing 0.12
Minimum Metal 1 to Contact enclosure 0
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Minimum Metal 1 to Contact enclosure on two opposite sides of the Contact 0.06
Minimum Metall area 0.07
Minimum Metal k width 0.14
Maximum Metal k width 12

Minimum Metal k enclosure of Via k-1 0.005
Minimum Metal k enclosure of Via k-1on at least two opposite sides 0.06
Minimum Metal k area 0.08
Minimum and maximum Via k width 0.14
Minimum Via k to Via k spacing 0.15
Minimum Metal k to Via k enclosure 0.005
Minimum Metal k to Via k enclosure on at least two opposite sides of Via k 0.06

Minimum of four Via k with spacing <= 0.30um or nine Via k with spacing <=
0.60um are required when connecting Metal k and Metal k+1 when one of the
Metals has a width > 1.0um at the connection point

Minimum Nwell width 0.6
Minimum Nwell spacing to Nwell (same potential) 0.6
Minimum Nwell spacing to Nwell (different potential) 1.2
Minimum Nwell spacing to N+/P+ Active Area 0.3
Minimum Nwell enclosure of N+/P+ Active Area 0.12
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EEE 4134 VLSI | Laboratory
Lab 4

DRC, LVS, RCX and Post-layout simulation of an inverter

Objectives:
e To perform Design rules check (DRC), Layout vs. Schematic check (LVS) of inverter
layout

e To extract parasitic resistance and capacitance from layout of designed inverter
e To perform transient simulation of extracted view
e To create layout views for body ties of NMOS and PMOS for further use

DRC Rules check by Cadence’s ASSURA

1. Now we would like to check the DRC rules by ASSURA. Execute Assura->Technology. In the
following window, type the path of ‘Assura Technolgy File’ as shown. Click OK.
X Assura Technology Lib Select — O >

&Sssura Technology File ftech/process//gpdk090/assura_tech. Lib| Wieny | Edit.

_ Cancel . Apply | Defaults | Help
2. Execute Assura-Run DRC. A DRC window appears as shown below. Fill the form as indicated
in the picture.
Give a Run name. Select ‘gpdk090’ under ‘Technology’. Then click OK.
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M Run Assura DRC — O >
Layout Design Source  (DFII n Compare two layouts | ((Senemate Lyl Compare Rules:.
Library mylih Cell  IHNVEL Wiew Layout Erowse...
Save Edracted View Yiew Mame  drc_extracted

&rea To Be Checked  (Full n

Run Mame deel] Run Directory
M

Run Location local i@

Wiew Rules Files ¥  Technology gpdk030 n Rule Set default ﬂ

— FRules File Jtechiprocess//gpdk090/assurasdre. rul \ Wiew.. | Reload

Switch Mames ! set Switches
—  RSF Include ! Wi J
Yariahle Yalue Default Description

Mane n

YView avParameters ! kodify avParameters.. J & avParameters are set

View Additional Functions - Mo additional functions are set.

Enable limitDrcCheck

@I concel  apply  Defaults | Load State | Save State | View RSF | Help

3. A DRC completed window appears as shown below, after completion of DRC run:
X Run'drc1” from. hasc.. — O x

The DRC run "drc1® from
“fthomesfalll 620705001 /cic™

@ has completed successully.

Do you weant to view the results of this run®

Yes ] Help

Click Yes.
4. ‘Error layer Window’ (ELW) appear as shown below with INVX1 layout window which shows
the errors.
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X Error Layer Window - O *
File  Wiew Error-Visihility  Show Error by Help cadence
[2] ¥1a1 .07 Metall must connect to Metal2 with == 2 Vial spaced < 0.30 um 0 _Signoff 0 _Fixed
Rules Filter: B MY + > 4 ¥ Cell Filter: & G &

2 [2] VIA1.X.1: Metall must connect to Metalz with »= 2 Vial spaced < 0,30 ... |2 | INVXT layout mylib
[2] MIMP.E 4 Mimp to gate end enclosure must be == 0.6 um
[2] FIMP.E.4: Pimp to gate end enclosure must be == 0.18 um

5. To correct the errors, find the error location by clicking on the error and then clicking on the
right arrow key on ELW. To hide all the errors, click on ‘NV’ (no Layers visible) button.

The particular error in the following figure is due to a lower than 0.18 um enclosure of gate by
Pimp (drw) layer. Stretch the Pimp layer to correct it. Similarly, do this for all errors in your layout.
No one can list all the errors one may commit, try correcting one after another and be familiar with
them by solving them through practice.

After correcting all the errors, run the DRC again.
6. If your design is error free, you should get the following message.

X - o X

@ Mo DRC errors found.
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LVS check by Cadence’s ASSURA

1. Execute Assura-Run LVS. Select gpdk090 and give a Run name.

X Run Assura LVS — O >
Schematic Design Source  (DFI n Use Existing Metlist ) Metlisting Optians...
Use Verilog Top Cell

Library mylib Cell  INVEL Yiew achematic Browse...
Layout Design Source DFIl n Use Existing Extracted Metlist J

Library mylib Cell  INVEL Yiew Llayout Browse...
Fun Matme Twsl Run Directory

P

Fun Laocation local n
Wiew Rules Files ¥  Technalogy gpdkO30 n Rule Set |default B

Ll Extract Rules Ftech/process/ qpdk090 fassura extract. rul LU= , Reload
—  Compare Bules  Stech/process/gpdk090/assurascompare. rul Wi J
awitch Mames et Switches
— EBinding Filefs)  /tech/process//gpdk090/assura/bind. rul Yigw... J
— RSF Include Ftech/fprocess Aqpdk090/assura LV5include. rsf B J
Yariable Yalue Default Description
Mone n
View avParameters rodify avParameters.. J ¥ avParameters are setf.

Yiesy avCompareRules

kodify ayCompareRules... J 1 avCompare rule is set.

Wiew Additional Functions Mo additional functions are set.

m Cancel Apply Defaults Load State Save State Yiew RSF Help

Click OK.

2. After completion of lvs run, you will get a result window. If you have done everything right, it
will say that Schematic and Layout match.

Suppose that, you have done a mistake, your schematic says the PMOS width is 480n where layout
says it is 240n. What will happen in LVS report? Let’s see.
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X Run: "lvs1" has completed SUCCESSFULLY! — O *

i autoPinSwap () results for schematic network.

The L¥S run "lwsl" has completed successfully

Compare problems were detected in 1 cells
1 cells had parsmeters mismatches.
0 cells matched

No Extraction Problems were detected.
Tou currently have an open run (project).
Press "OE" to close this run and enter the L¥S Debug Environment.

Press "Cancel" to leawe this run open and close this Dialog hox.

LY¥S Run "lwsl"
iz located in Jhomefa1116/120105001 fcic/

Il y

Frew. Errar Prew. Warn. et YWarn. Mext Error
- 7 7 A -

Note that, LVS report says that 1 cell had parameter mismatch. That means one cell had two

different dimensions in schematic and layout. Click OK. ‘LVS Debug’ window will appear:
[£] LVS Debug - vs — O ¥

File “iew Options Tools Help CEdEI‘It‘.E

| _ Esfract ® Compare

|
Cell List (sch || lay) Summary (sch || 1ay)

INVEL {mylib} I INVHL {my

-~ B
[ -

Dpeh Schematic. Cell.,. Dipen Layout Cell... Dper Taal...
¥ ¥ g 4

q |
3. Select INVX1 (mylib). Notice that summary window shows the list of errors.

|
| _ Exfract ® Compare sSummary (sch || lay)

Cell List (sch || 1ay)

INVEL {mylib} IMVEL {7 Rewires N
Hets 1
Devices I}
Pins o) o

Parameters 1

&

4. Only parameter mismatch has occurred. Click on Parameters and Open Tool.
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|
summary (sch || 1ay)

Fewires n

Hets I}

Devices I}

Pins o) o
1

Cpen Tool...

5. ‘Parameters mismatch tool” will open.

[€] Parameters Mismatch Tool - O x
File Options Wiew Tools  Help cadence
achilLay Cells  INVEL {mylib} [ INWEL {mylib}
MMessage

Schematic Info () Layout Info ()

Mame rame

PMO pmoslv avDT 1 pmosly

Froke P u ] Remove. Frobe P[] Remoyve.

10 |

6. Select PMO pmoslv. Now in the Message box, you can see the mismatch error.

SchilLay Cells  INVEL{mylib}

| INVEL {mylib}

Message Err: MOS Sch LW 1e-07 4. 8e-07; Lay L/W le-07 2. 4e-07

Schematic Info ()

MHame

Layout Info ()

MHame

MM

7. Change the width of PMOS to the value of width in layout and run LVS again. This time you

will get an LVS match.
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X Run: "lvs1" — O >

Burn: "lvs1" from
fhomeffalll 620105007 fcicd

schematic and Layout Match.

You currently have an open run (project).

Do you want to close current project and view the results of new run®
summary of LVS [ssues

Exstraction Information:

0 cells have 0 mal-formed device problems
0 cells have 0 label short problems
0 cells have 0 label open problems

iComparison Information:

0 cells have 0 Met mismatches

0 cells have O Device mismatches

0 cells have O Fin mismatches

0 cells have O Parameter mismatches

ELW Information:

Taotal DRC wiolations: 0

Yes B Help

Parasitic Extraction by Quantus QRC

1. Execute Assura-=>Open Run. Select the final error free lvs run name in the run name field (it
automatically loads the last Ivs run). Click OK.

X Open Run — O >

Run Direct
un Directory M J

Bun Mame [vs1 n - LVE Debug Environment... || LWS Error Report... \ ERLC Erowser.. J

zancel Help

2. Execute Assura=Run Quantus QRC. Select Extracted View in the output field under Setup
tab.
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<>< Cuantus QRC (Assura) Parasitic Extraction Run Form - O >
Setup Extraction Filtering Medlisting Run Details substrate
Technology (@pdk030 n RuleSet default n a
— pZlvsset MOMNE o UseriultRulesets — o
—  Setup Dir Ftech/fprocess fqpdk090 /fassurarox -
— Include Command File x_.xw\.ﬂ'tx
Rule Command File Include &E&; &
— Tech Cmd File (User ™ | /ey (Bt
| Library Definitions File  /home/£21116,/120105001 /cic/eds. 1ib = :‘”i"ﬂ & .
Output  Exdracted View Lib mylib  Cell INVEL  View av_extracted
Enable CellView Check L]
Parasitic Res Component presistor Frop Id r
Parasitic Cap Component poapacitor Frop Id =
Parasitic Ind Component pinductor Frop Id 1
Parasitic kM Component prind Frop Id k
Inductance L1 Prop |d indl Inductance LZ Prop |d ind2
Parasitic CCVS Component W Hygain Frop [d hng Yref Prop o W
Parasitic %5 Component VSOULCE Frod Id VI
Call Procedure
Substrate Extract o Substrate Profile MOMNE n
Add LS MOS Diffusion Fes Extract MOS Diffusion Res L el

o
-
LIULSL Y DILIEUCLULY U opELL LY S LI ELCLULY LUL I;‘J.J.L,J.]!U:I 10rdl LIl JdL IR CTLEJLEL

during the hierarchical extraction of an extracted wiew.

=

-~ B =

mx Cancel  Apply | Defaults | Load state | Save State

. Wiesw Command File | Help

3. Go to Extraction tab. Select RC as Extraction type and put the name of your reference node
(gnd! in the given case) and click OK.
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Setup Extraction Filtering Metlisting Run Details aubstrate

Estraction Type \RC n Mame Space Layout Mames n

e fracture [ength infinite MICrans n Temperature 25,0 C | Edit

Cap Coupling Mode  |\Decoupled n Ref Mode

grud !

4. After completion of the run, you will get the following message:
X Quantus QRC Run — O >

The Guantus GRC run “lvs1" completed successiully
The output is in :

Libirary: mylib
Cell:  INWET
YWiew: av_extracted

5. Execute File=2Open and fill in the form as follows. Click OK.

‘}( Open File — O "
File

. ) Cells

Libirar tylib

L _
Cell THVEL inwerter
inwerter?
W e av_extracted n inwerter3
Type layout
Browwse

Application
Open with  (Layout L n
_ Ahkays use this application for this type of file

Open for & edit  read

Library path file  /home /£all16/120105001 /cicfcds. 1ib

\ Cancel | Help

Extracted view will open.

Page 68



EEE 4134 VLSI I Sessional

1
HA_m r‘r1||r_‘l.'_:i 1w

6. Now Launch ADE L from the av_extracted view and setup everything other than outputs to be
plotted in the same way as you have done in Lab 1. After setting everything else, execute
Outputs=>To be plotted = Select on design. Go to av_extracted view. Click on the in pin location
on that view. The following window will appear. Select pin name in and click OK. Do the same for
out pin.

X Select nets/terminals — O >

fin

Ll

§ zancel o Help ;

Then run the simulation and observe the output waveforms. Then measure power and delay using
waveform calculator.

QUESTIONS:
What happens to delay and power consumption after parasitic RC effects are included? And explain
why it happens.
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Creating Layout views of Body ties

Now you know what body tie is. We will now make two instances for body ties one for Psub and
one for Nwell.

1. Execute File 2New =>Cellview and fill in the New File form as follows. Click OK.

X Mew File - O X
File

Library mylib B

Cell M1 _PSUE|

Wieny layout

Type [z ot =
Application

Open with Layout L n

_ Always use this application for this type of file

Library path file
fhome £a31116/120105001 /cicfocds. Lib

_Cancel) _tielp._

2. Draw psubstrate contact in the same way as you have made it in Lab3.

B EE 006

006 Ok D
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3. Save it and make nwell contact similarly (name it M1_NWELL), just change the Pimp layer to
Nimp and everything else is the same.
Save these two for later use.
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EEE 4134 VLSI | Laboratory
Lab 5

Schematic Driven Layout of a 2-input NAND gate using Virtuoso Layout Suite
Editor XL

Objectives:
e To be familiar with schematic-driven layout with the example of a 2-input NAND gate.
e To perform Schematic Level Verification, Layout Design, DRC and LVS check and
perform post-layout simulation from extracted view

Creating Layout using Virtuoso Layout Editor XL

1. Virtuoso Layout Editor XL is a schematic-driven layout generation tool. To learn schematic
driven layout we will create the schematic view of a 2-input NAND gate cell which we named
NAND2X1.

2. Instantiate the following cells to your schematic.

Library Name Cell Name | PropertiessfComment

gpdk090 nmoslv For NMO and NM1, Width = 240n
gpdk090 pmoslv For PMO and PM1, Width = 480n
analogLib vdd

analogLib gnd

Use your experience from Lab1l to draw the schematic diagram of the nand gate.

" apdkROF_priostvt T apdkROA prios iy
‘|E|1m1n ‘“:_J\lmun

) m: m:
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3. Launch ADE L and simulate the design to verify its functionality. Setup Model library,
Analysis type and Outputs to be plotted as you have done in Lab1.

While setting inputs for signals A and B, you have to use different periods and delays for the two
signals, so that you can observe all four cases (00, 01, 10, 11) of input signals. Also make sure 0>1
and/or 1->0 transitions for both input signals do not occur at the same time. The following figure
shows a sample of two signals meeting these criteria:

A
I

|
Voltage (B) O I
I
I

<

I

I

I

I

>

DeIIay I Period (B) |

Timei(B) |

0

I
|
|
|
|
|
|
I
|
]
I
|
I
|
|
|
|
I

Voltage (A)

<‘>I< . >
Delay Period (A)

Time(A) Time

A sample waveform window would look like the following after simulation:
F] mylib NANDZXT schematic [

Check the functionality of the schematic (whether it acts like a nand gate).
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4. Then create a symbol in the same way you have made symbol of inverter in lab2. Make it look
like a nand gate.

5. In schematic editor window, execute: Launch =>Layout XL. The following window will appear:
X, Startup Option — O >
Physical Implementation Startup Options

Layout
® Create Mew . Open Existing

Configuration
— Create Mew  Open Existing

® Asutomatic
@Y concel Hel
6. Click OK. ‘New File’ window for layout will appear. Click OK.
X New File - O X
File
Library mylib B
Cell NANDZE1|
Wiew layout
Type lay out ﬂ
Application
Open with Layout xL

_ Alvays use this application for this type of file

Likirary path file
Shome f£21116 /120105001 feic feds. 1ik

‘Virtuoso Layout Editor XL’ window will appear.
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E Virtuoso® Layout Suite XL Editing: mylib NAND2X1 layout — O x

Launch File Edit Yiew Create ‘“erify Connectivity Options Tools Window  &ssura Optimize »(édEl’ICE

= ¢ |4{%:> L fE __".B: QL = | G = :]E » || & » ||| Classic n»
(4, < & :?EIH';;;H fo) O] 08 Oy » ||Fiselectd Selpyd Selrn Sel(0)o0 | b

Paletie TR X

Layers 5 X

» Walid _ Used _ Routing
Q B-
el drawing n

B RS a5 5

Name | Wis | 3el |

+ =+ -

Layer |Pu. ] ¥ | 5|
[FOE] dr W W)=
Cixide dny W gu

W Cide_thk dry w2 @
B Foly dra W W
B Fimp dry W
Objects il
Objects [
- nstances W W=

. -

Fins W W
P WiAs L
Objects Grids

A& EEQTYESE - MHE-EBEEERE 25
= b @oc RS BEDD R (B E
7. Execute Connectivity = Generate All From Source. The following pop-up window will appear:
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I}( Generate Layout
Generate [¥2 Pins FR Boundary Floorplan

Generate

¥ Instances
_ Chain _ Fold Chain Folds
¥ /0 Pins
_ Except Global Pins
_ Except Pad Pins
PR Boundary
__ =Shap Boundary

<

Position
Minimum Separation: 0. 12| ¥ In Boundary

Device Correspondence

_ Preserve User-Defined Bindings

Connectivity Extraction

¥ Extract Connectivity after Generation

izancel Defaults Help

8. Go to 1/0 pins tab. The dialog box shows that all I/O pins are in Metall layer (Metall drw).
Also put a tick mark on Create label as Label. Click Options. Set Height to 0.1.
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X Generate Layout — O x
Generate £ Ping PR Boundary Floorplan
Specify Default VYalues for All Fins
Layer: Width:  Height  Mum: Create:

W et=11  |dow =0.12| 0.1z 1 Apply

Specify Pins to be Generated

Select: Number Of Matches: 0 Jhdd New Fin..
Term Mame  Met Mame Layer Width Height Mum Create
"B “EM i("Metall" “drawing") n.12 o012 1 t
"B" "E" ("Metall" “drawing") n.12 o012 1 t
e e ("Metall" “drawing") n.12 0.1z 1 t
“grnd !t “gnd " ("Metall" “drawing") 0.1z 0.1 1 t
“ddl” "rddl ("Metall" “drawing") o1z o1z 1 t
Hame: Layer: Width:  Height:  Mum: Create:

] N 0.1z 01z 1 o« Wpdaie

Fin Label
¥ Create Label A5: & Label Options...

N —
o Text Display

zancel Defaults Help

X SetPinlab.. — | X

Height 0. 1]

Fant stick n

Click OK, and OK.
9. The initial pin and transistor placement in layout will look like the following:
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10. Execute Options=>Display or Press ‘€’ on keyboard to open ‘Display Options’. Fill it in as
shown:
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M Display Options
Display Controls

Open to Stop Level
HRes

LU

Instance Qriging
EIF Surround
Fin Mames ¥
Dot Ping

Met Expressions
stretch Handles
Yia Shapes

<

<

Dynamic Hilight
Dragged Ohject Ghost
_ Traversed instance BEox

1< |

Maximum Drag Level 32

Mets

access Edges
Instance Pins
array lcons
Lahel Originsg
Use True EBox
Cross Cursor

Riw Mame

_ Row Site

» True Color Drag
Transparent Group
__ selection Hint

Faximum Mumber of Drag Figures 500

Scroll Percent 25

Instance Drawing Mode | BEOX

Fath Display

‘Bnrders and Centerlines n

Set LPP Wisibility Do not check validity n

Show Mame Of o instance &

Array Display

master . hoth

Display Levels

& Full Start ]
. Border
— S0Urce Sz 10
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O x
Grid Controls
Type  _ none @ dots o lines
Dim kajor Dots L
kinor Spacing 0.0l
kAajor Spacing 0.1
. 5nap Spacing 0.00s
Y Snap Spacing 0.00s
Filter
Size 6 style empty g
Snap Modes
Create orthogonal :
Edit orthogonal [
Dimiming
Enable Dimming L
SCDpE _nune
Dim Grid Lings

Automatic Dimming

Dim Intensity:

Dim Selected Ohject Content

True Colar Selection only

® Cellviews o Library . Tech Library . File «f. cdsenw Browse...
Save To Load From Celete From
m - Cancel o Defaults oS apply oS Help )
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11. The transistors and pins are shown inside a bounding box, which is an estimate of the optimum
size of the final layout. Automatic router will use the bounding box to constrain all routing to occur
within the box. The bounding box may need to be re-sized to accommodate all components. An
important concept to keep in mind during resizing is that standard cells typically have fixed height
(so that power/ground rails line up correctly for routing purposes).
Delete the PR Boundary for now.
Virtuoso Layout Editor XL (VXL) and gpdk090 allow us to create stacked transistors with shared
source/drain areas. Zoom in to two transistors at the bottom (to zoom in, type “z”” and draw a box
around the transistors). Click on the transistor on the right and type “m” to move the object. As
you start dragging the object to the left, fly-lines indicating connectivity will appear as shown
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12. When the source/drain areas are overlapped, left-click to fix the position. You should see a
transistor stack with shared source/drain areas like this (depending on how far you move, you may
need to move left/right a bit):

This is a nice NMOS stack for the NAND gate. As you can see, the source/drain contacts have
disappeared. Back to the big picture, zoom to fit (press “f”).
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Let’s do the same exercise for the PMOS transistors. The PMOS transistors in nand gate do have
shared drain contacts because they work in parallel. Connectivity information is extracted from
schematic by VXL. The pull-up network looks like the follwoing:

13. Now, connect different layers using path tool (press ‘p’ on keyboard), and fill areas by drawing
rectangles where necessary (press ‘r’ on keyboard). To connect one layer to another (e.g. Poly to
Metall or Metall to Metal2), create via by pressing ‘0’ on keyboard and selecting proper ‘Via

Defintion’.

X Create Via - O *
Mode & Single o Stack o Auto
Cptions . Compute From Shape(s)
Met Name
_ Create as ROD Object Man vial
Wia Definition  M1_POy n . Standard Via / gpdk090

14. Instantiate M1_PSUB and M1_NWELL cells (that you have created earlier) by pressing ‘i' on
keyboard and selecting the layout view from library browser.
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X Library Browser - Create Instance — O x

_ Show Categories

Library Cell View

ik BT MWYELL laspout

analogLib MY 1 ‘h.r'lew ~| Lock | Size
avTech A — T —T
hasic k41 PSLIB

cdsDefTechLib MAMDEZX1

gpdk04s inverter

gpdk0ao inverter?

gpdkiao inverterd

sample

stdcell

15. Wire up the layout. When you do so, you may encounter multiple options for certain pins. For
example, when you select the PMOS to connect its source to VDD, there are multiple Metall wires
in the PMOS. The desired path will be highlighted and you’ll see the fly-line. Continue until you
finish routing all the signals. Move vdd! and gnd! pins to the power rails. As you are moving the
pins around, notice the fly-lines that indicate the connections.

A practice that you can follow while wiring is to use Metall for all vertical wiring and Metal2 for
all horizontal wiring inside the cell.
Also make the cell height 5 um.

16. Your final layout will look something like the following:
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17. Perform DRC, LVS and QRC for NAND2X1 as you have done in Lab 4. Generate
av_extracted view and simulate the circuit from that view to verify the functionality.

QUESTIONS:
Why should you stack transistors in a layout which have shared drain/source? What are the

differences between stacked transistors and unstacked ones in terms of performance of post-layout
simulation?
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EEE 4134 VLSI | Laboratory
Lab 6

Introduction to Hierarchical Design (2-input AND gate using 2-input NAND
gate and an inverter)

Objectives:
e To be familiar with concept of hierarchical design
e To perform Schematic Level Verification, Layout Design, DRC and LVS check
e To perform post-layout simulation of top level design

Introduction to Hierarchical Design

By this time, you should have completed layout of INVX1 and NAND2X1. Now, you will learn how
to perform hierarchical design.

1. Create a new cellview of type schematic named AND2X1.

2. Instantiate NAND2X1 and INVX1 symbol from your library mylib in that schematic.

Your final schematic should look something like the following:

Frbty M Cr

3. Now make a symbol of AND2X1.

AHDENT

4. Now create a new cellview named AND2X1 _test, instantiate AND2X1 and vdd in that cell and the
final schematic should look like the following:
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AMOZH

5. Now, launch ADE L, setup Stimuli, Model library, Analysis type and Outputs to be plotted in

the same way as you have done in Lab 5. Run the simulation.
F1 mylib 4MD2X1_test schematic £

Transient Response Sat Apr 15 14;

00 20 40 &0 S0 100 120 140 150 120 20 26 00320 340 260 3280 400 420 440 450

6. If functional verification is okay, then execute Launch-Layout XL from the schematic of
AND2X1.

7. Follow procedure of Lab 5 to generate instances and set display options. You will get something
like the following:
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8. Connect them as required and the final layout should look like the following (probably better!):
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5 S H
grid! G red.

9. Perform DRC, LVS and QRC as you have done in Lab 4 and Lab 5.

QUESTIONS:
What is hierarchical design? What design principles will make hierarchical layout design easier?
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EEE 4134 VLSI | Laboratory
Lab 7

Introduction to Verilog HDL and Quartus II

Objectives:

e To get familiar with Quartus Il
e To get introduced to Hardware Description Language (HDL)
e To understand behavioral and structural Verilog descriptions

Verilog HDL

A hardware description language (HDL) is similar to a typical computer programming language
except that an HDL is used to describe hardware rather than a program to be executed on a
computer. Two HDLs are IEEE standards: Verilog HDL and VHDL (Very High Speed Integrated
Circuit Hardware Description Language).

Creating a New Project

1. Run Quartus Il by clicking on the shortcut icon on desktop named Quartus Il 9.0spl Web
Edition. A getting started window may open up. You may put a tick on ‘Don’t show this screen
again’, if you do not want this to appear again.

2. Each logic circuit or sub-circuit being designed with Quartus 11 software is called a project. The
software works on one project at a time and keeps all the information for that project in s single
directory (folder) in the file system. To begin a new logic circuit design, the first step is to create a
directory to hold its files. Create a folder in D:\, E:\ or F:\ drive named after your student ID.
Execute File 2New Project Wizard. Click Next on the window that opens up.

3. In the following window, change the working directory of the project to your directory (e.g.
D:\120105001) and give a name to the project as shown. Note that the project must have a hame,
which is usually the same as the top-level design entity that will be included in the project.
Click Next.
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New Project Wizard: Directory, Name, Top-Level Entity [page 1 of 5] l&J
What is the working directory for this project?
lD:\VeliIog
What is the name of this project?
!mux_2101[

‘What is the name of the top-level design entity for this project? This name is case sensitive and must [|
exactly match the entity name in the design file.

]mux_2l01

Use Existing Project Settings .. ’

< Back | Next > I Finish | Cancel l

4. We can specify any existing file to be included in the project, if we want, in the next window.

But we will skip it for now. Click Next on the next three windows that open up. Then in the last
window, click Finish.

Creating a new Verilog HDL file under a project (Design Entry), Compilation
and Simulation

1. Execute File >New. A window will open up. Select Verilog HDL File and click OK.

2. The following Text Editor Window will open up and you can write your Verilog code in here
and save it using the same name as the project.

b

3be Verilogl.v I

[@ 1

< m

3. Write your Verilog code. This example shows Verilog code for a 2tol MUX.
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P mux_2tol.v | &b Compilation Report - Flow Summs
i Emodule mux 2tol(A,B,5,Y):;

= 2 input A,B,S:;
dh 27 3 output ¥Y;

4 assign Y=(S5&B) | (~5&A);

’ S endmodule
i £ 3
A4 %
A %

The syntax of Verilog code is sometimes difficult for a designer to remember. To help with the
issue, the Text Editor provides a collection of Verilog templates. The templates provides examples
of various types of Verilog statements, such as a module declaration, an always block, and
assignment statements. It is worthwhile to browse through the templates by selecting Edit->Insert
Template 2Verilog HDL to become familiar with this resource.

4. Click on the purple play button to start compilation of your Verilog code.
oGRS D: b Pe D 2O B 2| e

5. After successful compilation, you will get the following message. Ignore the Warnings for now.
Click OK.

Quartus I ﬁ

101 Full Compilation was successful (5 warnings)

If the compiler does not report zero errors, then there is at least one mistake in Verilog code. In this
case, a message corresponding to each error found will be displayed in the Messages window.
Double-clicking on an error message will highlight the statement which is affected by the error, in
the Verilog code in the Text Editor window. The user can obtain more information about a specific
error by selecting the error and pressing the F1 function key. Correct the error and recompile the
design.

6. Now, execute File 2New to create a vector waveform file which is required for simulating inputs
and outputs. Select Vector Waveform File from the list and click OK.

7. The following window will open up.
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Master Time Bar: 15.075 ns v/ Painter: | Ops Interval: | -15.08 ns Start: | " End:|

ps 100ns 200ns 300ns

15.075ns
]

e Value at
15.08ns

< O KRN

8. Double-click on the white space under ‘Name|Value at 15.08 ns’. Or Right-click on that space
and select Insert=>Insert Node or Bus.

9. In the ‘Insert Node or Bus’ window, click Node Finder.

Insert Node or Bus

X
Narne: ]| 0K I
Type: [INPUT | Cancel
Value type: | ILevel =] Node Finder...
Radix: |asc -]
Bus width: l1
Start index: IU
[ Display aray code count as binary count

10. In the ‘Node Finder’ window, Click List. Make sure ‘Pins:all’ is selected under ‘Filter’.

11. Now the window will look like the following one. Click on the >>’ Button.
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Named: |" LI Filter: lPins: all ;' Customize... I List ' A 0K
~]..| ¥ Include subenties  Stop l ’ Cancel |
Nodes Found: Selected Nodes:
Name I Assighments | 3 Name l Assignments I ]
| [ 5 Unassigned |
BB Unassigned |
|| DS Unassigned |
[ 2% Unassigned  (
]|
I >
, =3
' [=]
' << I
|
|
I |
I I+ - » | . - b
7]

12. Now, it should appear like the following. Click OK.

Node ﬁnZer # “
- -

;j Filter: IPins: all ;] Customize... I List I @ oK |
vl _J IV Include subentities Stop I Cancel I
Nodes Found: Selected Nodes:
Name IAssignrnen!s l i Name I Assignments l i
[ |=a Unassigned | 9 [mux_2to |4 Unassigned |
B Unassigned | 9 [mux_2tol|B Unassigned |
| |m>s Unassigned | 9 [mux_2to1(S Unassigned |
| =y Unassigned  ( £ [mux_2tollY Unassigned  (
B
l >
| 2]
| =
I <« |
|
’ |
|
I e N d » < I ol »
24

13. In the following window, click OK.
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Name:

Insert Node or Bus M
0K

Type: I “Multiple ltems™ ZI Cancel |
Value type: | ILevel | IWI
Radix: |ascn ~]

Bus width: |1

Start index: IU

I Display gray code count as binary count

l”‘M ultiple Items™* |

14. The vector waveform file will now look like the following:

@ | Master Time Bar: 15075 ns «| | Pointer: Ops Interval: 1508 ns Stat
. A Value &t ps 100ns 200ns
R Name | 4508 15.075ns
% @ o ¥
0 A AD
~ w1 B AD
# % (32 s AO
)@ X o»3 Y AX
1°r ILI

Now, you can clearly see the inputs and outputs.

15. Select an input and from the left palette, click on the ‘Overwrite clock’ icon.

16. In the ‘Clock’ window, set parameters of the clock.
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Clock e
— Time range
Start time: [U Ips _v_l
End time: l1.0 Ius Ll

— Base waveform on
g

* Time period:
Period:  |10.0 [ns 3
|

Offset.  [0.0 |ns

Duty cycle (%): 150 ;1

oK | Cancel |

17. Now, after setting all the input clocks, Vector Waveform File will look like the following.
Note that, the output Y is displayed as having an unknown value at that time, which is indicated by
a hashed pattern; its value will be determined during simulation.

@ Master Time Bar: 15.075 ns «| »| Pointer: 500 ps Interval: 1458 ns Start: End:
% A o Value at ps 10.0ns o 200ns 300ns 40.0ns 50.0ns 60.0ns
15.08 ns U/ons
C 0N b
g |20 A AT | | J | [ | | | | | l_
~ 1 B Al

#h &) w2 S AQ | | —

x |3 Y AX | R B B B B B BB BERBEEREB8E
B% 41

P T m

18. Save the Vector Waveform File. It must have the same name as the Verilog file.

19. A designed circuit can be simulated in two ways. The simplest way is to assume that there is no
delay in propagation of signals through the circuit. This is called functional simulation. A more
complex way is to take all propagation delays into account, which leads to timing simulation.
Typically, functional simulation is used to verify the functional correctness of a circuit as it is being
designed. This takes much less time, because the simulation can be performed simply by using the
logic expressions that define the circuit.

Click on the blue play button and you should observe the simulated waveforms.
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Kesewe | orvrvo[E]e® 40|

Simulation Waveforms

Simulation mode: Timing

‘ k Master Time Bar: | 15.075 ns «| »| Painter: Interval: | Start: | End:

A oo ps 10.9 ns 20.9 ns 30.9 ns 40.9 ns 509 ns 60.9 ns
ey Name 15.08 ns 15.07“5 ns

Q@] » | a1 — 111
By |1 B A @

M B2 S A0 | |

n 123 Y Al I I I I I I I -
i

_’
jVVE%;

2l

< L [ T

Note there is a delay between input and outputs which simulates the real effect of gate delays. If
you are interested in only functional analysis rather than timing analysis, go through some more
steps.

20. Execute Processing =>Simulator Tool.

21. In the following window, select Functional as Simulation Mode and click on Generate
Functional Simulation Netlist.

£ Simulator Tool fro |- S|
Simulation mode: [Functional ~] Generate Functional Simulation Netist |
Simulation input: ~[mux_2o1. vt .. | AddMulte Files... |

22. After generating functional simulation netlist, the following window will appear. Click OK.

Quartus II @

| Functional Simulation Netlist Generation was successful (6 warnings)

OK

|-

23. Click on the blue play button and you should observe the following message.

Mrs@we v rwnos[E]e © 20

Page 95



EEE 4134 VLSI I Sessional

;l Simulator was successful

24. Now observe the simulation waveforms from Processing 2Simulation Report, and note that
there is no time delay between inputs and output and the function of this code is indeed that of a

2tol MUX.
Simulation Waveforms
Simulation mode: Functional
| MasterTimeBar|  15075ns  «[»|Pointer|  153ns  Intewal|  1355ns  Sta End|
A Vakue at ps 10'.0 ns 20.9 ns 30.9 ns 4D.p ns 509 ns GO.P n
B Name | 1508 ns 15-07P‘5 ns
,Cl\ 0 A Al | | [ | | | | | |
By |1 B A1l I 1 I 1 1
™ 2 S AD | 1 [
= @3 Y A1 I 1 | | e
g
_’
2l
« N R
QUESTIONS:

1. Which ones of the following identifier names are incorrect according to Verilog syntax?
2tolMUX, MUX$2tol, mux 2tol, reg, reg4bit, 130105 counter
2. What are the differences between ‘structural’ and ‘behavioral’ Verilog codes? Show an example of each

for a particular logic circuit.
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EEE 4134 VLSI | Laboratory
Lab 8

Combinational Logic circuit design in Verilog HDL using Quartus Il

Objectives:

e To design combinational circuits with Verilog codes, and verify the codes through
simulation
e To learn about hierarchical design using Verilog HDL

Verilog codes for combinational logic circuits

Half-Adder

module half adder (A,B,Cout,S);
input A, B;

output S, Cout;

assign S = A"B;

assign Cout = A&B;

endmodule

2-to-1 MUX

module mux2l1 fn (IO, IlS,f);
input I10,1I1,S;
output reg f£;
always@ (I0,I1, S)
begin

if (S == 0)

f = I0;

else

f =1I1;

end

endmodule

Priority Encoder

module priority (W, Y, z);
input [3:0]W;

output reg [1:0]Y;

output reg z;

always @ (W)

begin

z = 1;
casex (W)
4"pblxxx:
4"p01lxx:
4"p001x:
4'p0001:
default: begin
z = 0;

Y = 2'bx;

end

endcase

end

endmodule
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Full Adder using Half-Adders

module FA 001 (A,B,C,Cout,S);
input A,B,C;

output Cout, S;

wire C1,C2,S1;

HA 001 f1(A, B, Cl1l, s1);
HA 001 f2(s1, C, C2, S);
assign C = Cl|C2;
endmodule

module HA 001 (a,b,c,s);
input a,b;

output ¢, s;

assign c = aé&b;

assign s = a"b;
endmodule

2-to-4 Decoder

module dec2tod4 (W, En, Y);
input [1:0]W;

input En;

output reg [0:3]Y;

integer k;

always@ (W, En)

for(k = 0; k < = 3; k = k+1)
if ((W == k) && (En == 1))
Y[k] = 1;

else

Y[k] = 0;

endmodule
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QUESTIONS:
1. What are the differences between ‘concurrent’ and ‘procedural’ statements? Show an example of
each.

2. Examine whether the following two code segments will yield different outputs. Explain your
reasoning.

always@ (w0 ,wl,s) always@*
begin begin
if (s==0) if (s==0)
begin begin
f=w0; f=w0;
end end
else else
begin begin
f=wl; f=wl;
end end
end

3. Use ‘subcircuit’ concept of Verilog syntax to make a 4-to-1 MUX using 2-to-1 MUXes. Write
the Verilog code.
4. Read the following Verilog code and find out what it does. State your reasoning.

module ques4 (w,y);
input [3:0]w;
output reg [1:0]y;

always@ (w)
begin
casex (w)
‘b1000:y=3;
‘bx100:y=2;
‘bxx10:y=1;
default:y=0;
endcase
end
endmodule

4. Write Verilog codes for-
1 digit BCD Adder, 4-to-1 MUX, 4-bit comparator, 7-segment decoder, n-bit adder, 4-bit Full-
Adder using 1-bit Full-Adder modules, 16-to-1 MUX using 4-to-1 MUXes
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EEE 4134 VLSI | Laboratory
Lab 9

RTL synthesis and Sequential Logic Circuit design in Verilog HDL using
Quartus 11

Objectives:

e To get familiar with RTL Synthesis in Quartus 11
e To design sequential logic circuits in Verilog HDL, and verify the codes through simulation

RTL Synthesis in Quartus Il

Logic synthesis is a process by which an abstract form of desired circuit behavior), is turned into a
design implementation in terms of logic gates, by a synthesis tool. Common examples of this
process include synthesis of HDLs, including VHDL and Verilog. Some synthesis tools
generate bit-streams for programmable logic devices such as PALs or FPGAs, while others target
the creation of ASICs. Logic synthesis is one aspect of electronic design automation.

In digital circuit design, register-transfer level (RTL) is a design abstraction which models
a synchronous digital circuit in terms of the flow of digital signals (data) between hardware
registers, and the logical operations performed on those signals. Register-transfer-level abstraction
is used in hardware description languages (HDLs) to create high-level representations of a circuit,
from which lower-level representations and ultimately actual wiring can be derived.

1. Write Verilog code for a logic circuit, compile it and verify its functionality through simulation.

Suppose, you have completed all these steps for Verilog code of a half-adder.

1 Emodule halfadder (&,B,Cout,5):
2 input 4L, B!

3 output 5, Cout:

4q as=zign 5§ = A"E;

5 aszign Cout = A&E;

6 endmodule

-

Then you can proceed to obtain RTL view for this logic circuit.
2. Execute Tools =>Netlist Viewers 2RTL Viewer. A window will appear and you can see the RTL
view.

Cout~0

Al

I
E

As you can see, this is the logic circuit for a half-adder.
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Verilog codes for sequential logic circuits

Latch

module latch (D, clk,Q);
input D, clk;

output reg O;
always@ (D, clk)

if (clk)

0=D;

endmodule

Flip-flop

module flipflop (D, Clock, Q) ;
input D,Clock;

output reg O;

always(@ (posedge Clock)
Q<=D;

endmodule

Shift Register

module shift3(w,Clock,Q);
input w,Clock;

output reg [1:3]0Q;
always(@ (posedge Clock)
begin

Q[3]<=w;

Q[2]<=QI[3];

Q[1]<=QI[2];

end

endmodule

Counter

module count4 (Clock,Resetn,E,Q);

input Clock,Resetn, E;
output reg [3:0]0Q;

always@ (posedge Clock, negedge Resetn)

if (Resetn==0)

0<=0;
elseif (E)
Q<=0+1;
endmodule
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QUESTIONS:

1. Find out the function of following logic circuit and write a Verilog code to obtain the same logic
circuit in ‘RTL Viewer’.

Q-~0 Q~regl
—{ ) -
Tl o @ o
o1 | 97 -
| _OD—_D_ .

clk|

2. Write Verilog codes for an n-bit up/down counter, which counts up if select pin=0 and counts
down if select pin=1.

3. Write Verilog code for a universal shift register which can shift left/right and can load data both
in parallel mode and serial mode.

4. Write Verilog code for a J-K flip-flop using D flip-flop and a T flip-flop using J-K flip-flop
5. Synthesize already written Verilog codes to obtain RTL diagrams.

6. Write the Verilog code for a logic circuit which counts to 3 if selection input (composed of 2
bits) §,S, = 01, counts to 7, if ;. S, = 10, counts to 15, if 5, S, = 11. If §;5, = 00, then it halts
counting. Use positive edge-triggered counter.

7. What are the differences between ‘synchronous’ and ‘asynchronous’ resettable flip-flops?

8. Find 10 mistakes in the following Verilog code which implements a 5-bit shift register:

module 8ques (w,clk,Q)
Parameter n=5;

input w,clk

output [n-1:1]qg;

always@ (posedge clk) ;

begin
q[5]1=w;
ql[4]1=q[5];
ql31=q[4];
ql2]1=q[3];
qlll=q[2];

end

end

9. What are the differences between ‘blocking’ and ‘non-blocking’ assignments? Show how only
the use of them creates entirely different logic circuits.
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